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chapter01
第1章 はじめに

1.1 関数型JavaScript

関数型プログラミングの手法は、かねてよりJavaScriptでも用いられてきました。


	UnderscoreJSなどのライブラリは、 mapや filter、 reduceといったよく知られた関数を活用して、小さいプログラムを組み合わせて大きなプログラムを作れるようにします。



    var sumOfPrimes =
        _.chain(_.range(1000))
         .filter(isPrime)
         .reduce(function(x, y) {
             return x + y;
         })
         .value();



	NodeJSにおける非同期プログラミングでは、第一級の値としての関数をコールバックを定義するために多用しています。



    require('fs').readFile(sourceFile, function (error, data) {
      if (!error) {
        require('fs').writeFile(destFile, data, function (error) {
          if (!error) {
            console.log("File copied");
          }
        });
      }
    });



	Reactやvirtual-domなどのライブラリは、アプリケーションの状態についての純粋な関数としてその外観をモデル化しています。



関数は単純な抽象化を可能にし、優れた生産性をもたらしてくれます。しかし、JavaScriptでの関数型プログラミングには欠点があります。JavaScriptは冗長で、型付けされず、強力な抽象化を欠いているのです。また、無秩序に書かれたJavaScriptコードでは、式の理解がとても困難です。

PureScriptはこのような問題を解決すべく作られたプログラミング言語です。PureScriptは、とても表現力豊かでありながらわかりやすく読みやすいコードを書けるようにする、軽量な構文を備えています。強力な抽象化を提供する豊かな型システムも採用しています。また、JavaScriptやJavaScriptへとコンパイルされる他の言語と相互運用するときに重要な、高速で理解しやすいコードを生成します。PureScriptをひとことで言えば、純粋関数型プログラミングの理論的な強力さと、JavaScriptのお手軽で緩いプログラミングスタイルとの、とても現実的なバランスを狙った言語だということを理解して頂けたらと思います。

1.2 型と型推論

動的型付けの言語と静的型付けの言語をめぐる議論についてはよく知られています。PureScriptは静的型付けの言語、つまり正しいプログラムはコンパイラによってその動作を示すような型を与えられる言語です。逆にいえば、型を​​与えることができないプログラムは誤ったプログラムであり、コンパイラによって拒否されます。動的型付けの言語とは異なり、PureScriptでは型はコンパイル時のみに存在し、実行時には型の表現はありません。

PureScriptの型は、これまでJavaやC#のような他の言語で見たような型とは、いろいろな意味で異なっていることにも注意することが大切です。おおまかに言えばPureScriptの型はJavaやC#と同じ目的を持っているものの、PureScriptの型はMLとHaskellのような言語に影響を受けています。開発者がプログラムについての強い主張を表明できるので、PureScriptの型は表現力豊かなのです。最も重要なのは、PureScriptの型システムは型推論(type inference)をサポートしていることです。型推論があれば明示的な型注釈は必要最低限となり、型システムを厄介者ではなく道具にしてくれます。簡単な例を示すと、次のコードは数を定義していますが、それが Number型だという注釈はコードのどこにもありません。

iAmANumber =
  let square x = x * x
  in square 42.0


次のもっと複雑な例では、コンパイラにとって未知の型が存在しているときでさえも、型注釈なしで型の正しさを確かめることができるということが示されています。

iterate f 0 x = x
iterate f n x = iterate f (n - 1) (f x)


ここで xの型は不明ですが、 xがどんな型を持っているかにかかわらず、 iterateが型システムの規則に従っていることをコンパイラは検証することができます。

静的型はプログラムの正しさについての確信を得るためだけではなく、その正しさによって開発を助ける、ということをあなたに納得させる(もしくは、あなたの理解を確認する)ことをこの本では試みます。最も単純な抽象化を使わないかぎりJavaScriptでコードの大規模なリファクタリングすることは難しいですが、型検証器のある表現力豊かな型システムは、リファクタリングさえ楽しく対話的な体験にしてくれます。

加えて、型システムによって提供されたこのセーフティネットは、より高度な抽象化をも可能にします。実際に、関数型プログラミング言語Haskellによって知られるようになった、型主導の強力な抽象化である『型クラス』をPureScriptは備えています。

1.3 多言語Webプログラミング

関数型プログラミングはすでに多くの成功を収めています。特に成功している応用例をいくつか挙げると、データ解析、構文解析、コンパイラの実装、ジェネリックプログラミング、並列処理などがあります。

PureScriptのような関数型言語は、アプリケーション開発の最初から最後までを​実施することが可能です。値や関数の型を提供することで既存のJavaScriptコードをインポートし、通常のPureScriptコードからこれらの関数を使用する機能をPureScriptは提供しています。この手法については本書の後半で見ていくことになります。

しかしながら、PureScriptの強みのひとつは、JavaScriptを対象とする他​​の言語との相互運用性にあります。アプリケーションの開発の一部にだけPureScriptを使用し、JavaScriptの残りの部分を記述するのに他の言語を使用するという方法もあります。

いくつかの例を示します。


	中核となる処理はPureScriptで記述し、ユーザーインターフェイスはJavaScriptで記述する

	JavaScriptや、他のJavaScriptにコンパイルされる言語でアプリケーションを書き、PureScriptでそのテストを書く

	既存のアプリケーションのユーザインタフェースのテストを自動化するためにPureScriptを使用する



この本では小規模な課題をPureScriptで解決することに焦点を当てますが、ここで学ぶ手法は大規模なアプリケーションに組み込むこともできます。JavaScriptからPureScriptコードを呼び出す方法、およびその逆についても見ていきます。

1.4 ソフトウェア要件

この本でのソフトウェア要件は最小限です。第１章では開発環境の構築を一から案内します。これから使用するツールは、ほとんどの現代のオペレーティングシステムの標準リポジトリで使用できるものです。

PureScriptコンパイラ自体は、コンパイル済みバイナリ形式でダウンロードすることもできますし、最新のHaskellコンパイラが稼働しているシステム上でソースからビルドすることもできます。次の章ではこの手順を説明していきます。

本書のこのバージョンのコードは、 0.11.*バージョンのPureScriptコンパイラと互換性があります。

1.5 読者について

読者はJavaScriptの基本をすでに理解しているものと仮定します。すでにNPMやBowerのようなJavaScriptのエコシステムでの経験があれば、自身の好みに応じて標準設定をカスタマイズしたい場合などに役に立ちますが、そのような知識は必要ではありません。

関数型プログラミングの予備知識は必要ありませんが、あっても害にはならないでしょう。実例には新しいアイデアがつきものですから、これから使う関数型プログラミングからこうした概念に対する直感的な理解を得ることができるはずです。

PureScriptはプログラミング言語Haskellに強く影響を受けているため、Haskellに通じている読者はこの本の中で提示された概念や構文の多くに見覚えがあるでしょう。しかしながら、読者はPureScriptとHaskellの間にはいくつか重要な違いがあることも理解しておかなければなりません。ここで紹介する概念の多くはHaskellでも同じように解釈できるとはいえ、どちらかの言語での考え方を他方の言語でそのまま応用しようとすることは、必ずしも適切ではありません。

1.6 本書の読み進めかた

本書の各章は、概ね章ごとに完結しています。しかしながら、多少の関数型プログラミングの経験がある初心者でも、まずは各章を順番に進めていくことをおすすめします。最初の数章では、本書の後半の内容を理解するために必要な基礎知識を養います。関数型プログラミングの考え方に十分通じた読者(特にMLやHaskellのよう強く型付けされた言語での経験を持つ読者)なら、本書の前半の章を読まなくても、後半の章のコードの大まかな理解を得ることがおそらく可能でしょう。

各章ではそれぞれひとつの実用的な例に焦点をあて、新しい考え方を導入するための動機付けとして用います。各章のコードは本書のGitHubのリポジトリから入手できます。各章にはソースコードから抜粋したコード片が掲載されていますが、完全に理解するためには本書に掲載されたコードと平行してリポジトリのソースコードを読む必要があります。対話式環境 PSCiで実行し理解を確かめられるように、長めの節には短いコード片が掲載されていることがあります。

コード例は次のように等幅フォントで示されています。

module Example where

import Control.Monad.Eff.Console (log)

main = log "Hello, World!"


先頭にドル記号がついた行は、コマンドラインに入力されたコマンドです。

$ pulp build


通常、これらのコマンドはLinuxやMac OSの利用者ならそのまま適用できますが、Windowsの利用者はファイル区切り文字を変更する、シェルの組み込み機能をWindowsの相当するものに置き換えるなどの小さな変更を加える必要があるかもしれません。

pulp repl対話式プロンプトに入力するコマンドは、行の先頭に山括弧が付けられています。

> 1 + 2
3


各章には演習が付いており、それぞれ難易度も示されています。各章の内容を完全に理解するために、演習に取り組むことを強くお勧めします。

この本は初心者にPureScriptへの導入を提供することを目的としており、問題についてのお決まりの解決策の一覧を提供するような種類の本ではありません。初心者にとってこの本を読むのは楽しい挑戦になるはずですし、本書の内容を読み演習に挑戦すればだいたいの利益を得られるでしょうが、なにより重要なのは、あなたが自分自身のコードを書いてみることです。

1.7 困ったときには

もしどこかでつまずいたときには、PureScriptを学べるオンラインで利用可能な資料がたくさんあります。


	PureScript IRCチャン​​ネルはあなたが抱える問題についてチャットするのに最適な場所です。IRCクライアントでirc.freenode.netをポイントし、#purescriptチャンネルに接続してください。

	PureScriptのウェブサイトにはPureScriptの開発者によって書かれたブログ記事や、初心者向けの動画、その他のリソースへのリンクがあります。

	PureScriptコンパイラのドキュメントは、言語の主要な機能についての簡単​​なコード例があります。

	Try PureScript!ではユーザーがWebブラウザでPureScriptコードをコンパイルすることができます。また、ウェブサイトにはコードの簡単な例がいくつか含まれています。

	Pursuitは、PureScriptの型や関数を検索することができるデータベースです。



もしあなたが例を読んで学ぶことを好むなら、GitHubの purescript組織、 purescript-node組織および purescript-contrib組織にはPureScriptコードの例がたくさんあります。

1.8 著者について

私はPureScriptコンパイラの最初の開発者です。私はカリフォルニア州ロサンゼルスを拠点にしており、8ビットパーソナルコンピュータ、Amstrad CPC上のBASICでまだ幼い時にプログラミングを始めました。それ以来、私はいくつものプログラミング言語(JavaやScala、C#、F#、HaskellそしてPureScript)で業務に携わってきました。

プロとしての経歴が始まって間もなく、私は関数型プログラミングと数学の関係を理解するようになり、そしてプログラミング言語Haskellとの恋に落ちました。

JavaScriptでの経験をもとに、私はPureScriptコンパイラの開発を始めることにしました。私は自分がHaskellのような言語から取り上げた関数型プログラミングの手法を使っていることに気が付きましたが、それを応用するためのもっと理にかなった環境を求めていました。そのとき検討した案のなかには、Haskellをその意味論を維持しながらJavaScriptへとコンパイルするいろいろな試み(Fay、Haste、GHCJS)もありましたが、私が興味を持っていたのは、この問題への別の切り口からのアプローチ、すなわちHaskellのような言語の構文と型システムを楽しみながらJavaScriptの意味論も維持するということが、どのようにすれば可能になるのかでした。

私はウェブサイトを運営しており、Twitterで連絡をとることもできます。

1.9 謝辞

現在の状態に到達するまでPureScriptを手伝ってくれた多くの協力者に感謝したいと思います。コンパイラやツール、ライブラリ、ドキュメント、テストでの組織的で弛まぬ努力がなかったら、プロジェクトは間違いなく失敗していたことでしょう。

この本の表紙に表示されたPureScriptのロゴはGareth Hughesによって作成されたもので、Creative Commons Attribution 4.0 licenseの条件の下で再利用させて頂いています 。

最後に、この本の内容に関する反応や訂正をくださったすべての方に、心より感謝したいと思います。


chapter02
第2章 開発環境の準備

2.1 この章の目標

この章の目標は、作業用のPureScript開発環境を準備し、最初のPureScriptプログラムを書くことです。

これから書く最初のコードはごく単純なPureScriptライブラリで、直角三角形の対角線の長さを計算する関数ひとつだけを提供します。

2.2 導入

PureScript開発環境を準備するために、次のツールを使います。


	purs -  PureScriptコンパイラ本体

	npm - 残りの開発ツールをインストールできるようにする、Nodeパッケージマネージャ

	Pulp ​​- さまざまな作業をパッケージマネージャと連動して自動化するコマンドラインツール



この章ではこれらのツールのインストール方法と設定を説明します。

2.3 PureScriptのインストール

PureScriptコンパイラをインストールするときにお勧めなのは、PureScriptのウェブサイトからバイナリ配布物としてダウンロードする方法です。PureScriptコンパイラおよび関連する実行ファイルが、パス上で利用できるかどうか確認をしてください。試しに、コマンドラインでPureScriptコンパイラを実行してみましょう。

$ purs


PureScriptコンパイラをインストールする他の選択肢としては、次のようなものがあります。


	NPMを使用する。npm install -g purescript

	ソースコードからコンパイルを行う。この方法については、PureScriptのWebサイトが参考になります。



2.4 各ツールのインストール

もしNodeJSがインストールされていないなら、NodeJSをインストールする必要があります。そうするとシステムに npmパッケージマネージャもインストールされるはずです。 npmがインストールされ、パス上で利用可能であることを確認してください。

npmがインストールされたら、 pulpと bowerもインストールする必要があります。プロジェクトがどこで作業しているかにかかわらずこれらのコマンドラインツールが利用可能であるようにするため、通常はグローバルにインストールしておくのがいいでしょう。

$ npm install -g pulp bower


これで、最初のPureScriptプロジェクトを作成するために必要なすべてのツールの用意ができたことになります。

2.5 Hello, PureScript!

まずはシンプルに始めましょう。PureScriptコンパイラpulpを直接使用して、基本的なHello World! プログラムをコンパイルします。
最初に空のディレクトリmy-projectを作成し、そこでpulp initを実行します。

$ mkdir my-project
$ cd my-project
$ pulp init

* Generating project skeleton in ~/my-project

$ ls

bower.json	src		test


Pulpはsrcとtestという2つのディレクトリと設定ファイルbower.jsonを作成してくれます。srcディレクトリにはソースコードファイルを保存し、testディレクトリにはテストコードファイルを保存します。testディレクトリはこの本の後半で使います。

src/Main.pursという名前のファイルに、以下のコードを貼り付けてください。

module Main where

import Control.Monad.Eff.Console

main = log "Hello, World!"


これは小さなサンプルコードですが、​​いくつかの重要な概念を示しています。


	すべてのソースファイルはモジュールヘッダから始まります。モジュール名は、ドットで区切られた大文字で始まる1つ以上の単語から構成されています。ここではモジュール名としてひとつの単語だけが使用されていますが、 My.First.Moduleというようなモジュール名も有効です。

	モジュールは、モジュール名の各部分を区切るためのドットを含めた、完全な名前を使用してインポートされます。ここでは log関数を提供する Control.Monad.Eff.Consoleモジュールをインポートしています。

	この mainプログラムの定義本体は、関数適用の式になっています。PureScriptでは、関数適用は関数名のあとに引数を空白で区切って書くことで表します。



それではこのコードをビルドして実行してみましょう。次のコマンドを実行します。

$ pulp run

* Building project in ~/my-project
* Build successful.
Hello, World!


おめでとうございます!　はじめてPureScriptで作成されたプログラムのコンパイルと実行ができました。

2.6 ブラウザ向けのコンパイル

Pulpは pulp browserifyを実行して、PureScriptコードをブラウザで使うことに適したJavaScriptに変換することができます。

$ pulp browserify

* Browserifying project in ~/my-project
* Building project in ~/my-project
* Build successful.
* Browserifying...


これに続いて、大量のJavaScriptコードがコンソールに表示されます。 これはBrowserifyの出力で、Preludeと呼ばれる標準のPureScriptライブラリに加え、srcディレクトリのコードにも適用されます。このJavaScriptコードをファイルに保存し、HTML文書に含めることもできます。これを試しに実行してみると、ブラウザのコンソールに"Hello、World！"という文章が出力されます。

2.7 使用されていないコードを取り除く

Pulpは代替コマンド pulp buildを提供しています。 -Oオプションで未使用コードの削除を適用すると、不要なJavaScriptを出力から取り除くことができます。

$ pulp build -O --to output.js

* Building project in ~/my-project
* Build successful.
* Bundling Javascript...
* Bundled.


この場合も、生成されたコードはHTML文書で使用できます。 output.jsを開くと、次のようなコンパイルされたモジュールがいくつか表示されます。

(function(exports) {
  "use strict";

  var Control_Monad_Eff_Console = PS["Control.Monad.Eff.Console"];

  var main = Control_Monad_Eff_Console.log("Hello, World!");
  exports["main"] = main;
})(PS["Main"] = PS["Main"] || {});


ここでPureScriptコンパイラがJavaScriptコードを生成する方法の要点が示されています。


	すべてのモジュールはオブジェクトに変換され、そのオブジェクトにはそのモジュールのエクスポートされたメンバが含まれています。モジュールは即時関数パターンによってスコープが限定されたコードで初期化されています。

	PureScriptは可能な限り変数の名前をそのまま使おうとします。

	PureScriptにおける関数適用は、そのままJavaScriptの関数適用に変換されます。

	引数のない単純な呼び出しとしてメインメソッド呼び出しが生成され、すべてのモジュールが定義された後に実行されます。

	PureScriptコードはどんな実行時ライブラリにも依存しません。コンパイラによって生成されるすべてのコードは、あなたのコードが依存するいずれかのPureScriptモジュールをもとに出力されているものです。



PureScriptはシンプルで理解しやすいコードを生成すること重視しているので、これらの点は大切です。実際に、ほとんどのコード生成処理はごく軽い変換です。PureScriptについての理解が比較的浅くても、ある入力からどのようなJavaScriptコードが生成されるかを予測することは難しくありません。

2.8 CommonJSモジュールのコンパイル

pulpは、PureScriptコードからCommonJSモジュールを生成するためにも使用できます。 これは、NodeJSを使用する場合やCommonJSモジュールを使用してコードを小さなコンポーネントに分割する大きなプロジェクトを開発する場合に便利です。

CommonJSモジュールをビルドするには、（ -Oオプションなしで） pulp buildコマンドを使います。

$ pulp build

* Building project in ~/my-project
* Build successful.


生成されたモジュールはデフォルトで outputディレクトリに置かれます。 各PureScriptモジュールは、それ自身のサブディレクトリにある独自のCommonJSモジュールにコンパイルされます。

2.9 Bowerによる依存関係の追跡

この章の目的となっている diagonal関数を書くためには、平方根を計算できるようにする必要があります。 purescript-mathパッケージにはJavaScriptの Mathオブジェクトのプロパティとして定義されている関数の型定義が含まれていますので、 purescript-mathパッケージをインストールしてみましょう。 npmの依存関係でやったのと同じように、次のようにコマンドラインに入力すると直接このパッケージをダウンロードできます。

$ bower install purescript-math --save


--saveオプションは依存関係を bower.json設定ファイルに追加させます。

purescript-mathライブラリは、依存するライブラリと一緒に bower_componentsサブディレクトリにインストールされます。

2.10 対角線の長さの計算

それでは外部ライブラリの関数を使用する例として diagonal関数を書いてみましょう。

まず、 src/Main.pursファイルの先頭に次の行を追加し、 Mathモジュールをインポートします。

import Math (sqrt)


また、数値の加算や乗算のようなごく基本的な演算を定義する Preludeモジュールをインポートすることも必要です。

import Prelude


そして、次のように diagonal関数を定義します。

diagonal w h = sqrt (w * w + h * h)


この関数の型を定義する必要はないことに注意してください。 diagonalは2つの数を取り数を返す関数である、とコンパイラは推論することができます。しかし、ドキュメントとしても役立つので、通常は型注釈を提供しておくことをお勧めします。

それでは、新しい diagonal関数を使うように main関数も変更してみましょう。

main = logShow (diagonal 3.0 4.0)


pulp runを使用して、モジュールを再コンパイルします。

$ pulp run

* Building project in ~/my-project
* Build successful.
5.0


2.11 対話式処理系を使用したコードのテスト

PureScriptコンパイラには PSCiと呼ばれる対話式のREPL(Read-eval-print loop)が付属しています。 PSCiはコードをテストなど思いついたことを試すのにとても便利です。それでは、 psciを使って diagonal関数をテストしてみましょう。

pulp replコマンドを使ってソースモジュールを自動的に PSCiにロードすることができます。

$ pulp repl
>


コマンドの一覧を見るには、 :?と入力します。

> :?
The following commands are available:

    :?                        Show this help menu
    :quit                     Quit PSCi
    :reset                    Reset
    :browse           Browse 
    :type               Show the type of 
    :kind               Show the kind of 
    :show        import       Show imported modules
    :show        loaded       Show loaded modules
    :paste       paste        Enter multiple lines, terminated by ^D


Tabキーを押すと、自分のコードで利用可能なすべての関数、及びBowerの依存関係とプレリュードモジュールのリストをすべて見ることができるはずです。

Preludeモジュールを読み込んでください。

> import Prelude


幾つか数式を評価してみてください。 PSCiで評価を行うには、1行以上の式を入力し、Ctrl+ Dで入力を終了します。

> 1 + 2
3

> "Hello, " <> "World!"
"Hello, World!"


それでは PSCiで diagonal関数を試してみましょう。

> import Main
> diagonal 5.0 12.0

13.0


また、 PSCiで関数を定義することもできます。

> double x = x * 2

> double 10
20


コード例の構文がまだよくわからなくても心配はいりません。 この本を読み進めるうちにわかるようになっていきます。

最後に、 :typeコマンドを使うと式の型を確認することができます。

> :type true
Boolean

> :type [1, 2, 3]
Array Int


PSCiで試してみてください。もしどこかでつまずいた場合は、メモリ内にあるコンパイル済みのすべてのモジュールをアンロードするリセットコマンド ：resetを使用してみてください。

演習

	(簡単) Mathモジュールで定義されている pi定数を使用し、指定された半径の円の面積を計算する関数 circleAreaを書いてみましょう。また、 PSCiを使用してその関数をテストしてください。 (ヒント： import math文を修正して、 piをインポートすることを忘れないようにしましょう)

	(やや難しい) purescript-globalsパッケージを依存関係としてインストールするには、bower installを使います。PSCiでその機能を試してみてください。 (ヒント： PSCiの ：browseコマンドを使うと、モジュールの内容を閲覧することができます)





まとめ

この章では、Pulpツールを使用して簡単なPureScriptプロジェクトを設定しました。

また、最初のPureScript関数を書き、コンパイルし、NodeJSを使用して実行することができました。

以降の章では、コードをコンパイルやデバッグ、テストするためにこの開発設定を使用しますので、これらのツールや使用手順に十分習熟しておくとよいでしょう。


chapter03
第3章 関数とレコード

3.1 この章の目標

この章では、関数およびレコードというPureScriptプログラムのふたつの構成要素を導入します。さらに、どのようにPureScriptプログラムを構造化するのか、どのように型をプログラム開発に役立てるかを見ていきます。

連絡先のリストを管理する簡単​​な住所録アプリケーションを作成していきます。このコード例により、PureScriptの構文からいくつかの新しい概念を導入します。

このアプリケーションのフロントエンドは対話式処理系 PSCiを使うようにしていますが、JavaScriptでフロントエンドを書くこともできるでしょう。実際に後の章で、フォームの検証と保存および復元の機能追加について詳しく説明します。

3.2 プロジェクトの準備

この章のソースコードは src/Data/AddressBook.pursというファイルに含まれています。このファイルは次のようなモジュール宣言とインポート一覧から始まります。

module Data.AddressBook where

import Prelude

import Control.Plus (empty)
import Data.List (List(..), filter, head)
import Data.Maybe (Maybe)


ここでは、いくつかのモジュールをインポートします。


	Control.Plusモジュールには後ほど使う empty値が定義されています。

	purescript-listsパッケージで提供されている Data.Listモジュールをインポートしています。 purescript-listsパッケージはbowerを使用してインストールすることができ、連結リストを使うために必要ないくつかの関数が含まれています。

	Data.Maybeモジュールは、値が存在したりしなかったりするような、オプショナルな値を扱うためのデータ型と関数を定義しています。

	(訳者注・ダブルドット(..)を使用すると、指定された型コンストラクタのすべてのデータコンストラクタをインポートできます。)



このモジュールのインポート内容が括弧内で明示的に列挙されていることに注目してください。明示的な列挙はインポート内容の衝突を避けるのに役に立つので、一般に良い習慣です。

ソースコードリポジトリを複製したと仮定すると、この章のプロジェクトは次のコマンドを使用してPulpを使用して構築できます。

$ cd chapter3
$ bower update
$ pulp build


3.3 単純な型

JavaScriptのプリミティブ型に対応する組み込みデータ型として、PureScriptでは数値型と文字列型、真偽型の３つが定義されており、それぞれ Number、 String、 Booleanと呼ばれています。これらの型はすべてのモジュールに暗黙にインポートされる Primモジュールで定義されています。pulp replの :typeコマンドを使用すると、簡単な値の型を確認できます。

$ pulp repl

> :type 1.0
Number

> :type "test"
String

> :type true
Boolean


PureScriptには他にも、配列とレコード、関数などの組み込み型が定義されています。

整数は、小数点以下を省くことによって、型 Numberの浮動小数点数の値と区別されます。

> :type 1
Int


二重引用符を使用する文字列リテラルとは異なり、文字リテラルは一重引用符で囲みます。

> :type 'a'
Char


配列はJavaScriptの配列に対応していますが、JavaScriptの配列とは異なり、PureScriptの配列のすべての要素は同じ型を持つ必要があります。

> :type [1, 2, 3]
Array Int

> :type [true, false]
Array Boolean

> :type [1, false]
Could not match type Int with Boolean.


最後の例で起きているエラーは型検証器によって報告されたもので、配列の2つの要素の型を単一化(Unification)しようとして失敗したこと示しています。

レコードはJavaScriptのオブジェクトに対応しており、レコードリテラルはJavaScriptのオブジェクトリテラルと同じ構文になっています。

> author = { name: "Phil", interests: ["Functional Programming", "JavaScript"] }

> :type author
{ name :: String
, interests :: Array String
}


この型が示しているのは、オブジェクト authorは、


	String型のフィールド name

	Array Stringつまり Stringの配列の型のフィールド interests



という２つのフィールド(field)を持っているということです。

レコードのフィールドは、ドットに続けて参照したいフィールドのラベルを書くと参照することができます。

> author.name
"Phil"

> author.interests
["Functional Programming","JavaScript"]


PureScriptの関数はJavaScriptの関数に対応しています。PureScriptの標準ライブラリは多くの関数の例を提供しており、この章ではそれらをもう少し詳しく見ていきます。

> import Prelude
> :type flip
forall a b c. (a -> b -> c) -> b -> a -> c

> :type const
forall a b. a -> b -> a


ファイルのトップレベルでは、等号の直前に引数を指定することで関数を定義することができます。

add :: Int -> Int -> Int
add x y = x + y


バックスラッシュに続けて空白文字で区切られた引数名のリストを書くことで、関数をインラインで定義することもできます。PSCiで複数行の宣言を入力するには、 ：pasteコマンドを使用して"paste mode"に入ります。このモードでは、Control-Dキーシーケンスを使用して宣言を終了します。

> :paste
… add :: Int -> Int -> Int
… add = \x y -> x + y
… ^D


PSCiでこの関数が定義されていると、次のように関数の隣に２つの引数を空白で区切って書くことで、関数をこれらの引数に適用(apply)することができます。

> add 10 20
30


3.4 量化された型

前の節ではPreludeで定義された関数の型をいくつか見てきました。たとえば flip関数は次のような型を持っていました。

> :type flip
forall a b c. (a -> b -> c) -> b -> a -> c


この forallキーワードは、 flipが全称量化された型(universally quantified type)を持っていることを示しています。これは、 aや b、 cをどの型に置き換えても、 flipはその型でうまく動作するという意味です。

例えば、 aを Int、 bを String、 cを Stringというように選んでみたとします。この場合、 flipの型を次のように特殊化(specialize)することができます。

(Int -> String -> String) -> String -> Int -> String


量化された型を特殊化したいということをコードで示す必要はありません。特殊化は自動的に行われます。たとえば、すでにその型の flipを持っていたかのように、次のように単に flipを使用することができます。

> flip (\n s -> show n <> s) "Ten" 10

"10Ten"


a、 b、 cの型はどんな型でも選ぶことができるといっても、型の不整合は生じないようにしなければなりません。 flipに渡す関数の型は、他の引数の型と整合性がなくてはなりません。第２引数として文字列 "Ten"、第３引数として数 10を渡したのはそれが理由です。もし引数が逆になっているとうまくいかないでしょう。

> flip (\n s -> show n <> s) 10 "Ten"

Could not match type Int with type String


3.5 字下げについての注意

JavaScriptとは異なり、PureScriptのコードは字下げの大きさに影響されます(indentation-sensitive)。これはHaskellと同じようになっています。コード内の空白の多寡は無意味ではなく、Cのような言語で中括弧によってコードのまとまりを示しているように、PureScriptでは空白がコードのまとまりを示すのに使われているということです。

宣言が複数行にわたる場合は、２つめの行は最初の行の字下げより深く字下げしなければなりません。

したがって、次は正しいPureScriptコードです。

add x y z = x +
  y + z


しかし、次は正しいコードではありません。

add x y z = x +
y + z


後者では、PureScriptコンパイラはそれぞれの行ごとにひとつ、つまり2つの宣言であると構文解析します。

一般に、同じブロック内で定義された宣言は同じ深さで字下げする必要があります。例えば PSCiでlet文の宣言は同じ深さで字下げしなければなりません。次は正しいコードです。

> :paste
… x = 1
… y = 2
… ^D


しかし、これは正しくありません。

> :paste
… x = 1
…  y = 2
… ^D


PureScriptのいくつかの予約語（例えば whereや of、 let）は新たなコードのまとまりを導入しますが、そのコードのまとまり内の宣言はそれより深く字下げされている必要があります。

example x y z = foo + bar
  where
    foo = x * y
    bar = y * z


ここで fooや barの宣言は exampleの宣言より深く字下げされていることに注意してください。

ただし、ソースファイルの先頭、最初の module宣言における予約語 whereだけは、この規則の唯一の例外になっています。

3.6 独自の型の定義

PureScriptで新たな問題に取り組むときは、まずはこれから扱おうとする値の型の定義を書くことから始めるのがよいでしょう。最初に、住所録に含まれるレコードの型を定義してみます。

type Entry = { firstName :: String, lastName :: String, address :: Address }


これは Entryという型同義語(type synonym、型シノニム)を定義しています。 型 Entryは等号の右辺と同じ型ということです。レコードの型はいずれも文字列である firstName、 lastName、 phoneという３つのフィールドからなります。前者の２つのフィールドは型 Stringを持ち、 addressは以下のように定義された型 Addressを持っています。

type Address = { street :: String, city :: String, state :: String }


それでは、２つめの型同義語も定義してみましょう。住所録のデータ構造としては、単に項目の連結リストとして格納することにします。

type AddressBook = List Entry


List Entryは Array Entryとは同じではないということに注意してください。 Array Entryは住所録の項目の配列を意味しています。

3.7 型構築子と種

Listは型構築子(type constructor、型コンストラクタ)の一例になっています。 Listそのものは型ではなく、何らかの型 aがあるとき List aが型になっています。つまり、 Listは型引数(type argument)aをとり、新たな型 List aを構築するのです。

ちょうど関数適用と同じように、型構築子は他の型に並べることで適用されることに注意してください。型 List　Entryは実は型構築子 Listが型 Entryに適用されたものです。これは住所録項目のリストを表しています。

(型注釈演算子 ::を使って)もし型 Listの値を間違って定義しようとすると、今まで見たことのないような種類のエラーが表示されるでしょう。

> import Data.List
> Nil :: List
In a type-annotated expression x :: t, the type t must have kind Type


これは種エラー(kind error)です。値がその型で区別されるのと同じように、型はその種(kind)によって区別され、間違った型の値が型エラーになるように、間違った種の型は種エラーを引き起こします。

Numberや Stringのような、値を持つすべての型の種を表す Typeと呼ばれる特別な種があります。

型構築子にも種があります。たとえば、種 Type -> Typeはちょうど Listのような型から型への関数を表しています。ここでエラーが発生したのは、値が種 Typeであるような型を持つと期待されていたのに、 Listは種 Type -> Typeを持っているためです。

PSCiで型の種を調べるには、 :kind命令を使用します。例えば次のようになります。

> :kind Number
Type

> import Data.List
> :k List
Type -> Type

> :kind List String
Type


PureScriptの種システムは他にも面白い種に対応していますが、それらについては本書の他の部分で見ていくことになるでしょう。

3.8 住所録の項目の表示

それでは最初に、文字列で住所録の項目を表現するような関数を書いてみましょう。まずは関数に型を与えることから始めます。型の定義は省略することも可能ですが、ドキュメントとしても役立つので型を書いておくようにすると良いでしょう。型宣言は関数の名前とその型を ::記号で区切るようにして書きます。

showEntry :: Entry -> String


showEntryは引数として Entryを取り stringを返す関数であるということを、この型シグネチャは言っています。 showEntryの定義は次のとおりです。

showEntry entry = entry.lastName <> ", " <>
                  entry.firstName <> ": " <> 
                  showAddress entry.address


この関数は Entryレコードの３つのフィールドを連結し、単一の文字列にします。ここで使用される showAddressは addressフィールドを連接し、単一の文字列にする関数です。 showAddressの定義は次のとおりです。

showAddress :: Address -> String
showAddress addr = addr.street <> ", " <>
                   addr.city <> ", " <>
                   addr.state


関数定義は関数の名前で始まり、引数名のリストが続きます。関数の結果は等号の後ろに定義します。フィールドはドットに続けてフィールド名を書くことで参照することができます。PureScriptでは、文字列連結はJavaScriptのような単一のプラス記号ではなく、ダイアモンド演算子（ <>）を使用します。

3.9 はやめにテスト、たびたびテスト

PSCi対話式処理系では反応を即座に得られるので、試行錯誤を繰り返したいときに向いています。それではこの最初の関数が正しく動作するかを PSCiを使用して確認してみましょう。

まず、これまで書かれたコードをビルドします。

$ pulp build


次に、 PSCiを起動し、この新しいモジュールをインポートするために import命令を使います。

$ pulp repl

> import Data.AddressBook


レコードリテラルを使うと、住所録の項目を作成することができます。レコードリテラルはJavaScriptの無名オブジェクトと同じような構文で名前に束縛します。

> address = { street: "123 Fake St.", city: "Faketown", state: "CA" }


​それでは、この例に関数を適用してみてください。

> showAddress address

"123 Fake St., Faketown, CA"


そして、例で作成した addressを含む住所録の entryレコードを作成し showEntryに適用させましょう。

> entry = { firstName: "John", lastName: "Smith", address: address }
> showEntry entry

"Smith, John: 123 Fake St., Faketown, CA"


3.10 住所録の作成

今度は住所録の操作を支援する関数をいくつか書いてみましょう。空の住所録を表す値として、空のリストを使います。

emptyBook :: AddressBook
emptyBook = empty


既存の住所録に値を挿入する関数も必要でしょう。この関数を insertEntryと呼ぶことにします。関数の型を与えることから始めましょう。

insertEntry :: Entry -> AddressBook -> AddressBook


insertEntryは、最初の引数として Entry、第二引数として AddressBookを取り、新しい AddressBookを返すということを、この型シグネチャは言っています。

既存の AddressBookを直接変更することはしません。その代わりに、同じデータが含まれている新しい AddressBookを返すようにします。このように、 AddressBookは永続データ構造(persistent data structure)の一例となっています。これはPureScriptにおける重要な考え方です。変更はコードの副作用であり、コードの振る舞いについての判断するのを難しくします。そのため、我々は可能な限り純粋な関数や不変のデータを好むのです。

Data.Listの Cons関数を使用すると insertEntryを実装できます。 PSCiを起動し :typeコマンドを使って、この関数の型を見てみましょう。

$ pulp repl

> import Data.List
> :type Cons

forall a. a -> List a -> List a


Consは、なんらかの型 aの値と、型 aを要素に持つリストを引数にとり、同じ型の要素を持つ新しいリストを返すということを、この型シグネチャは言っています。 aを Entry型として特殊化してみましょう。

Entry -> List Entry -> List Entry


しかし、 List Entryはまさに AddressBookですから、次と同じになります。

Entry -> AddressBook -> AddressBook


今回の場合、すでに適切な入力があります。 Entryと AddressBookに Consを適用すると、新しい AddressBookを得ることができます。これこそまさに私たちが求めていた関数です！

insertEntryの実装は次のようになります。

insertEntry entry book = Cons entry book


等号の左側にある２つの引数 entryと bookがスコープに導入されますから、これらに Cons関数を適用して結果の値を作成しています。

3.11 カリー化された関数

PureScriptでは、関数は常にひとつの引数だけを取ります。 insertEntry関数は２つの引数を取るように見えますが、これは実際にはカリー化された関数(curried function)の一例となっています。

insertEntryの型に含まれる ->は右結合の演算子であり、つまりこの型はコンパイラによって次のように解釈されます。

Entry -> (AddressBook -> AddressBook)


すなわち、 insertEntryは関数を返す関数である、ということです！この関数は単一の引数 Entryを取り、それから単一の引数 AddressBookを取り新しい AddressBookを返す新しい関数を返すのです。

これは例えば、最初の引数だけを与えると insertEntryを部分適用(partial application)できることを意味します。 PSCiでこの結果の型を見てみましょう。

> :type insertEntry example

AddressBook -> AddressBook


期待したとおり、戻り値の型は関数になっていました。この結果の関数に、ふたつめの引数を適用することもできます。

> :type (insertEntry example) emptyBook
AddressBook


ここで括弧は不要であることにも注意してください。次の式は同等です。

> :type insertEntry example emptyBook
AddressBook


これは関数適用が左結合であるためで、なぜ単に空白で区切るだけで関数に引数を与えることができるのかも説明にもなっています。

本書では今後、「２引数の関数」というように表現することがあることに注意してください。これはあくまで、最初の引数を取り別の関数を返す、カリー化された関数を意味していると考えてください。

今度は insertEntryの定義について考えてみます。

insertEntry :: Entry -> AddressBook -> AddressBook
insertEntry entry book = Cons entry book


もし式の右辺に明示的に括弧をつけるなら、 （Cons entry）bookとなります。 insertEntry entryはその引数が単に関数 (Cons entry)に渡されるような関数だということです。この2つの関数はどんな入力についても同じ結果を返しますから、つまりこれらは同じ関数です！よって、両辺から引数 bookを削除できます。

insertEntry :: Entry -> AddressBook -> AddressBook
insertEntry entry = Cons entry


そして、同様の理由で両辺から entryも削除することができます。

insertEntry :: Entry -> AddressBook -> AddressBook
insertEntry = Cons


この処理はイータ変換(eta conversion)と呼ばれ、引数を参照することなく関数を定義するポイントフリー形式(point-free form)へと関数を書き換えるのに使うことができます。

insertEntryの場合には、イータ変換によって「 insertEntryは単にリストに対する consだ」と関数の定義はとても明確になりました。しかしながら、常にポイントフリー形式のほうがいいのかどうかには議論の余地があります。

3.12 あなたの住所録は？

最小限の住所録アプリケーションの実装で必要になる最後の関数は、名前で人を検索し適切な Entryを返すものです。これは小さな関数を組み合わせることでプログラムを構築するという、関数型プログラミングで鍵となる考え方のよい応用例になるでしょう。

まずは住所録をフィルタリングし、該当する姓名を持つ項目だけを保持するようにするのがいいでしょう。それから、結果のリストの先頭の(head)要素を返すだけです。

この大まかな仕様に従って、この関数の型を計算することができます。まず PSCiを起動し、 filter関数と head関数の型を見てみましょう。

$ pulp repl

> import Data.List
> :type filter

forall a. (a -> Boolean) -> List a -> List a

> :type head

forall a. List a -> Maybe a


型の意味を理解するために、これらの2つの型の一部を取り出してみましょう。

filterはカリー化された２引数の関数です。最初の引数は、リストの要素を取り Boolean値を結果として返す関数です。第２引数は要素のリストで、返り値は別のリストです。

headは引数としてリストをとり、 Maybe aという今まで見たことがないような型を返します。 Maybe aは型 aのオプショナルな値、つまり aの値を持つか持たないかのどちらかの値を示しており、JavaScriptのような言語で値がないことを示すために使われる nullの型安全な代替手段を提供します。これについては後の章で詳しく扱います。

filterと headの全称量化された型は、PureScriptコンパイラによって次のように特殊化(specialized)されます。

filter :: (Entry -> Boolean) -> AddressBook -> AddressBook

head :: AddressBook -> Maybe Entry


検索する関数の引数として姓と名前を渡す必要があるのもわかっています。

filterに渡す関数も必要になることもわかります。この関数を filterEntryと呼ぶことにしましょう。 filterEntryは Entry -> Booleanという型を持っています。 filter filterEntryという関数適用の式は、 AddressBook -> AddressBookという型を持つでしょう。もしこの関数の結果を head関数に渡すと、型 Maybe Entryの結果を得ることになります。

これまでのことをまとめると、この findEntry関数の妥当な型シグネチャは次のようになります。

findEntry :: String -> String -> AddressBook -> Maybe Entry


findEntryは、姓と名前の2つの文字列、および AddressBookを引数にとり、 Maybe Entryという型の値を結果として返すということを、この型シグネチャは言っています。結果の Maybe Entryという型は、名前が住所録で発見された場合にのみ Entryの値を持ちます。

そして、 findEntryの定義は次のようになります。

findEntry firstName lastName book = head $ filter filterEntry book
  where
    filterEntry :: Entry -> Boolean
    filterEntry entry = entry.firstName == firstName && entry.lastName == lastName


一歩づつこのコードの動きを調べてみましょう。

findEntryは、どちらも文字列型である firstNameと lastName、 AddressBook型の bookという3つの名前をスコープに導入します

定義の右辺では filter関数と head関数が組み合わされています。まず項目のリストをフィルタリングし、その結果に head関数を適用しています。

真偽型を返す関数 filterEntryは where節の内部で補助的な関数として定義されています。このため、 filterEntry関数はこの定義の内部では使用できますが、外部では使用することができません。また、 filterEntryはそれを包む関数の引数に依存することができ、 filterEntryは指定された Entryをフィルタリングするために引数 firstNameと lastNameを使用しているので、 filterEntryが findEntryの内部にあることは必須になっています。

最上位での宣言と同じように、必ずしも filterEntryの型シグネチャを指定しなくてもよいことに注意してください。ただし、ドキュメントとしても役に立つので型シグネチャを書くことは推奨されています。

3.13 中置の関数適用

上でみた findEntryのコードでは、少し異なる形式の関数適用が使用されています。 head関数は中置の $演算子を使って式 filter filterEntry bookに適用されています。

これは head (filter filterEntry book)という通常の関数適用と同じ意味です。

($)はPreludeで定義されている apply関数の別名で、次のように定義されています。

apply :: forall a b. (a -> b) -> a -> b
apply f x = f x

infixr 0 apply as $


ここで、 applyは関数と値をとり、その値にその関数を適用します。 infixrキーワードは ($)を applyの別名として定義します。

しかし、なぜ通常の関数適用の代わりに $を使ったのでしょうか？　その理由は $は右結合で優先順位の低い演算子だということにあります。これは、深い入れ子になった関数適用のための括弧を、 $を使うと取り除くことができることを意味します。

たとえば、ある従業員の上司の住所がある道路を見つける、次の入れ子になった関数適用を考えてみましょう。

street (address (boss employee))


これは $を使用して表現すればずっと簡単になります。

street $ address $ boss employee


3.14 関数合成

イータ変換を使うと insertEntry関数を簡略化できたのと同じように、引数をよく考察すると findEntryの定義を簡略化することができます。

引数 bookが関数 filter filterEntryに渡され、この適用の結果が headに渡されることに注目してください。これは言いかたを変えれば、 filter filterEntryと headの合成(composition) に bookは渡されるということです。

PureScriptの関数合成演算子は <<<と >>>です。前者は「逆方向の合成」であり、後者は「順方向の合成」です。

いずれかの演算子を使用して findEntryの右辺を書き換えることができます。逆順の合成を使用すると、右辺は次のようになります。

(head <<< filter filterEntry) book


この形式なら最初の定義にイータ変換の技を適用することができ、 findEntryは最終的に次のような形式に到達します。

findEntry firstName lastName = head <<< filter filterEntry
  where
    ...


右辺を次のようにしても同じです。

filter filterEntry >>> head


どちらにしても、これは「 findEntryはフィルタリング関数と head関数の合成である」という findEntry関数のわかりやすい定義を与えます。

どちらの定義のほうがわかりやすいかの判断はお任せしますが、このように関数を部品として捉え、関数はひとつの役目だけをこなし、機能を関数合成で組み立てるというように考えると有用なことがよくあります。

3.15 テスト、テスト、テスト……

これでこのアプリケーションの中核部分が完成しましたので、 PSCiを使って試してみましょう。

$ pulp repl

> import Data.AddressBook


まずは空の住所録から項目を検索してみましょう（これは明らかに空の結果が返ってくることが期待されます）。

> findEntry "John" "Smith" emptyBook

No type class instance was found for

    Data.Show.Show { firstName :: String
                   , lastName :: String
                   , address :: { street :: String
                                , city :: String
                                , state :: String
                                }
                   }


エラーです！でも心配しないでください。これは単に 型 Entryの値を文字列として出力する方法を PSCiが知らないという意味のエラーです。

findEntryの返り値の型は Maybe Entryですが、これは手作業で文字列に変換することができます。

showEntry関数は Entry型の引数を期待していますが、今あるのは Maybe Entry型の値です。この関数は Entry型のオプショナルな値を返すことを忘れないでください。行う必要があるのは、オプショナルな値の中に項目の値が存在すれば showEntry関数を適用し、そうでなければ存在しないという値をそのまま伝播することです。

幸いなことに、Preludeモジュールはこれを行う方法を提供しています。 map演算子は Maybeのような適切な型構築子まで関数を「持ち上げる」ことができます（この本の後半で関手について説明するときに、この関数やそれに類似する他のものについて詳しく見ていきます）。

> import Prelude
> map showEntry (findEntry "John" "Smith" emptyBook)

Nothing


今度はうまくいきました。この返り値 Nothingは、オプショナルな返り値に値が含まれていないことを示しています。期待していたとおりです。

もっと使いやすくするために、 Entryを文字列として出力するような関数を定義し、毎回 showEntryを使わなくてもいいようにすることもできます。

printEntry firstName lastName book
  = map showEntry (findEntry firstName lastName book)


それでは空でない住所録を作成してもう一度試してみましょう。先ほどの項目の例を再利用します。

> book1 = insertEntry entry emptyBook

> printEntry "John" "Smith" book1

Just ("Smith, John: 123 Fake St., Faketown, CA")


今度は結果が正しい値を含んでいました。 book1に別の名前で項目を挿入して、ふたつの名前がある住所録 book2を定義し、それぞれの項目を名前で検索してみてください。

演習

	
（簡単） findEntry関数の定義の主な部分式の型を書き下し、 findEntry関数についてよく理解しているか試してみましょう。たとえば、 findEntryの定義のなかにある head関数の型は AddressBook -> Maybe Entryと特殊化されています。



	
（簡単） findEntryの既存のコードを再利用し、与えられた電話番号から Entryを検索する関数を書いてみましょう。また、 PSCiで実装した関数をテストしてみましょう。



	
（やや難しい） 指定された名前が AddressBookに存在するかどうかを調べて真偽値で返す関数を書いてみましょう。 (ヒント：リストが空かどうかを調べる Data.List.null関数の型を psciで調べてみてみましょう)



	
（難しい） 姓名が重複している項目を住所録から削除する関数 removeDuplicatesを書いてみましょう。 (ヒント：値どうしの等価性を定義する述語関数に基づいてリストから重複要素を削除する関数 Data.List.nubByの型を、 psciを使用して調べてみましょう)







まとめ

この章では、関数型プログラミングの新しい概念をいくつか導入しました。


	対話的モード PSCiを使用して関数を調べるなど思いついたことを試す方法

	検証や実装の道具としての型の役割

	多引数関数を表現する、カリー化された関数の使用

	関数合成で小さな部品を組み合わせてのプログラムの構築

	where節を利用したコードの構造化

	Maybe型を使用してnull値を回避する方法

	イータ変換や関数合成のような手法を利用した、よりわかりやすいコードへの再構成



次の章からは、これらの考えかたに基づいて進めていきます。


chapter04
第4章 再帰、マップ、畳み込み

4.1 この章の目標

この章では、アルゴリズムを構造化するときに再帰関数をどのように使うかについて見ていきましょう。再帰は関数型プログラミングの基本的な手法であり、この本の全体に渡って使われます。

また、PureScriptの標準ライブラリから標準的な関数をいくつか取り扱います。mapやfoldのようなよく知られた関数だけでなく、filterやconcatMapといった珍しいけれど便利なものについても見ていきます。

この章では、仮想的なファイルシステムを操作する関数のライブラリを動機付けに用います。この章で学ぶ手法を応用して、擬似的なファイルシステムによって表されるファイルのプロパティを計算する関数を記述します。

4.2 プロジェクトの準備

この章のソースコードには、src/Data/Path.pursとsrc/FileOperations.pursという２つのファイルが含まれています。

Data.Pathモジュールには、仮想ファイルシステムが含まれています。このモジュールの内容を変更する必要はありません。

FileOperationsモジュールには、Data.PathAPIを使用する関数が含まれています。演習への回答はこのファイルだけで完了することができます。

このプロジェクトには以下のBower依存関係があります。


	purescript-maybe: Maybe型構築子が定義されています

	purescript-arrays: 配列を扱うための関数が定義されています

	purescript-strings: JavaScriptの文字列を扱うための関数が定義されています

	purescript-foldable-traversable: 配列の畳み込みやその他のデータ構造に関する関数が定義されています

	purescript-console: コンソールへの出力を扱うための関数が定義されています



4.3 はじめに

再帰は一般のプログラミングでも重要な手法ですが、特に純粋関数型プログラミングでは当たり前のように用いられます。この章で見ていくように、再帰はプログラムの変更可能な状態を減らすために役立つからです。

再帰は分割統治(divide and conquer)戦略と密接な関係があります。分割統治とはすなわち、いろいろな入力に対する問題を解決するために、入力を小さな部分に分割し、それぞれの部分について問題を解いて、部分ごとの答えから最終的な答えを組み立てるということです。

それでは、PureScriptにおける再帰の簡単な例をいくつか見てみましょう。

次は階乗関数(factorial function)のよくある例です。

fact :: Int -> Int
fact 0 = 1
fact n = n * fact (n - 1)


部分問題へ問題を分割することによって階乗関数がどのように計算されるかがわかります。より小さい数へと階乗を計算していくということです。ゼロに到達すると、答えは直ちに求まります。

次は、フィボナッチ関数(Fibonacci function)を計算するという、これまたよくある例です。

fib :: Int -> Int
fib 0 = 1
fib 1 = 1
fib n = fib (n - 1) + fib (n - 2)


やはり、部分問題の解決策を考えることで全体を解決していることがわかります。このとき、fib (n - 1)とfib (n - 2)という式に対応した、２つの部分問題があります。これらの２つの部分問題が解決されていれば、この部分的な答えを加算することで、全体の答えを組み立てることができます。

4.4 配列上での再帰

再帰関数の定義は、Int型だけに限定されるものではありません！本書の後半でパターン照合(pattern matching)を扱うときに、いろいろなデータ型の上での再帰関数について見ていきますが、ここでは数と配列に限っておきます。

入力がゼロでないかどうかについて分岐するのと同じように、配列の場合も、配列が空でないかどうかについて分岐していきます。再帰を使用して配列の長さを計算する次の関数を考えてみます。

import Prelude

import Data.Array (null)
import Data.Array.Partial (tail)
import Partial.Unsafe (unsafePartial)

length :: forall a. Array a -> Int
length arr =
  if null arr
    then 0
    else 1 + length (unsafePartial tail arr)


この関数では配列が空かどうかで分岐するためにif ... then ... else式を使っています。このnull関数は配列が空のときにtrueを返します。空の配列の長さはゼロであり、空でない配列の長さは配列の先頭を取り除いた残りの部分の長さより１大きいというわけです。

JavaScriptで配列の長さを調べるのには、この例はどうみても実用的な方法とはいえませんが、次の演習を完了するための手がかりとしては充分でしょう。

演習

	
(簡単) 入力が偶数であるとき、かつそのときに限りtrueに返すような再帰関数を書いてみましょう。



	
(少し難しい) 配列内の偶数の数を数える再帰関数を書いてみましょう。ヒント：Data.Array.PartialモジュールのunsafePartial head関数を使うと、空でない配列の最初の要素を見つけることができます。







4.5 マップ

map関数は配列に対する再帰関数のひとつです。この関数を使うと、配列の各要素に順番に関数を適用することで、配列の要素を変換することができます。そのため、配列の内容は変更されますが、その形状(ここでは「長さ」)は保存されます。

本書で後ほど型クラス(type class)を扱うとき、形状を保存しながら型構築子のクラスを変換する関手(functor)と呼ばれる関数を紹介しますが、その時にmap関数は関手の具体例であることがわかるでしょう。

それでは、PSCiでmap関数を試してみましょう。

$ pulp repl

import Prelude
map (\n -> n + 1) [1, 2, 3, 4, 5]

[2, 3, 4, 5, 6]


mapがどのように使われているかに注目してください。最初の引数には配列がどのように対応付けられるかを示す関数、第２引数には配列そのものを渡します。

4.6 中置演算子

バッククォート(`)で関数名を囲むと、対応関係を表す関数と配列のあいだに、map関数を書くことができます。

(\n -> n + 1) `map` [1, 2, 3, 4, 5]

[2, 3, 4, 5, 6]


この構文は中置関数適用と呼ばれ、どんな関数でもこのように中置することができます。普通は2引数の関数に対して使うのが最も適切でしょう。

配列を扱うときは、map関数と等価な
  
  
  chapter05
  

  
chapter05
第5章 パターン照合

5.1 この章の目標

この章では、代数的データ型とパターン照合という、ふたつの新しい概念を導入します。また、行多相というPureScriptの型システムの興味深い機能についても簡単に取り扱います。

パターン照合(Pattern matching)は関数​​型プログラミングにおける一般的な手法で、複数の場合に実装を分解することにより、開発者は潜在的に複雑な動作の関数を簡潔に書くことができます。

代数的データ型はPureScriptの型システムの機能で、パターン照合とも密接に関連しています。

この章の目的は、代数的データ型やパターン照合を使用して、単純なベクターグラフィックスを描画し操作するためのライブラリを書くことです。

5.2 プロジェクトの準備

この章のソースコードはファイル src/Data/Picture.pursで定義されています。

このプロジェクトでは、これまで見てきたBowerパッケージを引き続き使用しますが、それに加えて次の新しい依存関係が追加されます。


	purescript-globals: 一般的なJavaScriptの値や関数の取り扱いを可能にします。

	purescript-math: JavaScriptの Mathオブジェクトの関数群を利用可能にします。



Data.Pictureモジュールは、簡単な図形を表すデータ型 Shapeや、図形の集合である型 Picture、及びこれらの型を扱うための関数を定義しています。

このモジュールでは、データ構造の畳込みを行う関数を提供する Data.Foldableモジュールもインポートします。

module Data.Picture where

import Prelude
import Data.Foldable (foldl)


Data.Pictureモジュールでは、 Globalと Mathモジュールもインポートするため asキーワードを使用します。

import Global as Global
import Math as Math


これは型や関数をモジュール内で使用できるようにしますが、Global.infinityやMath.maxといった修飾名でのみ使用にできるようにします。これは重複したインポートをさけ、使用するモジュールを明確にするのに有効な方法です。

注意：同じモジュール名を修飾名に使用する場合には不要な作業です。一般的にはimport Math as Mなどの短い名前がよく使われています。

5.3 単純なパターン照合

それではコード例を見ることから始めましょう。パターン照合を使用して2つの整数の最大公約数を計算する関数は、次のようになります。

gcd :: Int -> Int -> Int
gcd n 0 = n
gcd 0 m = m
gcd n m = if n > m
            then gcd (n - m) m
            else gcd n (m - n)


このアルゴリズムはユークリッドの互除法と呼ばれています。その定義をオンラインで検索すると、おそらく上記のコードによく似た数学の方程式が見つかるでしょう。パターン照合の利点のひとつは、上記のようにコードを場合分けして定義することができ、数学関数の定義と似たような簡潔で宣言型なコードを書くことができることです。

パターン照合を使用して書かれた関数は、条件と結果の組み合わせによって動作します。この定義の各行は選択肢(alternative)や場合(case)と呼ばれています。等号の左辺の式はパターンと呼ばれており、それぞれの場合は空白で区切られた1つ以上のパターンで構成されています。等号の右側の式が評価され値が返される前に引数が満たさなければならない条件について、これらの場合は説明しています。それぞれの場合は上からこの順番に試されていき、最初に入力に適合した場合が返り値を決定します。

たとえば、 gcd関数は次の手順で評価されます。


	まず最初の場合が試されます。第２引数がゼロの場合、関数は n（最初の引数）を返します。

	そうでなければ、2番目の場合が試されます。最初の引数がゼロの場合、関数は m（第２引数）を返します。

	それ以外の場合、関数は最後の行の式を評価して返します。



パターンは値を名前に束縛することができることに注意してください。この例の各行では nという名前と mという名前の両方、またはどちらか一方に、入力された値を束縛しています。これより、入力の引数から名前を選ぶためのさまざまな方法に対応した、さまざまな種類のパターンを見ていくことになります。

5.4 単純なパターン

上記のコード例では、2種類のパターンを示しました。


	Int型の値が正確に一致する場合にのみ適合する、数値リテラルパターン

	引数を名前に束縛する、変数パターン



単純なパターンには他にも種類があります。


	文字列リテラルと真偽リテラル

	どんな引数とも適合するが名前に束縛はしない、アンダースコア（ _）で表されるワイルドカードパターン



ここではこれらの単純なパターンを使用した、さらに2つの例を示します。

fromString :: String -> Boolean
fromString "true" = true
fromString _      = false

toString :: Boolean -> String
toString true  = "true"
toString false = "false"


PSCiでこれらの関数を試してみてください。

5.5 ガード

ユークリッドの互除法の例では、 m > nのときと m 
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第6章 型クラス

6.1 章の目標

この章では、PureScriptの型システムによって可能になる強力な抽象化の手法である、型クラスを導入します。

この章ではデータ構造をハッシュするためのライブラリを題材に説明していきます。データ自身の構造について直接考えることなく複雑な構造のデータのハッシュ値を求めるために、型クラスの仕組みがどのようにして働くのかを見ていきます。

また、PureScriptのPreludeや標準ライブラリに含まれる、標準的な型クラスも見ていきます。PureScriptのコードは概念を簡潔に表現するために型クラスの強力さに大きく依存しているので、これらのクラスに慣れておくと役に立つでしょう。

6.2 プロジェクトの準備

この章のソースコードは、ファイル src/data/Hashable.pursで定義されています。

このプロジェクトには以下のBower依存関係があります。


	purescript-maybe: オプショナルな値を表す Maybeデータ型が定義されています。

	purescript-tuples: 値の組を表す Tupleデータ型が定義されています。

	purescript-either: 非交和を表す Eitherデータ型が定義されています。

	purescript-strings: 文字列を操作する関数が定義されています。

	purescript-functions: PureScriptの記述用の補助関数が定義されています。



モジュール Data.Hashableでは、これらのBowerパッケージによって提供されるモジュールのいくつかをインポートしています。

module Data.Hashable where

import Data.Maybe
import Data.Tuple
import Data.Either
import Data.String
import Data.Function


6.3 見せてください！(Show Me!)

型クラスの最初に扱う例は、すでに何回か見たことがある関数と関係しています。 showは、何らかの値を取り、それを文字列として表示する関数です。

showは Preludeモジュールの Showと呼ばれる型クラスで次のように定義されています。

class Show a where
  show :: a -> String


このコードでは、型変数 aでパラメータ化された、 Showという新しい型クラス(type class)を宣言しています。

型クラスインスタンスには、型クラスで定義された関数の、その型に特殊化された実装が含まれています。

例えば、Preludeにある Boolean値に対する Show型クラスインスタンスの定義は次のとおりです。

instance showBoolean :: Show Boolean where
  show true = "true"
  show false = "false"


このコードは showBool​​eanという名前の型クラスのインスタンスを宣言します。

PureScriptでは、生成されたJavaScriptの可読性を良くするために、型クラスインスタンスに名前をつけます。このとき、Boolean型は Show型クラスに属しているといいます。

PSCiで、いろいろな型の値をShow型クラスを利用して表示してみましょう。

> import Prelude
> show true
"true"

> show 1.0
"1.0"

> show "Hello World"
"\"Hello World\""


この例ではさまざまなプリミティブ型の値を showしましたが、もっと複雑な型を持つ値を showすることもできます。

> import Data.Tuple

> show (Tuple 1 true)
"(Tuple 1 true)"

> import Data.Maybe

> show (Just "testing")
"(Just \"testing\")"


型 Data.Eitherの値を表示しようとすると、興味深いエラーメッセージが表示されます。

> import Data.Either
> show (Left 10)

The inferred type

    forall a. Show a => String

has type variables which are not mentioned in the body of the type.
Consider adding a type annotation.


ここでの問題は showしようとしている型に対する Showインスタンスが存在しないということではなく、 PSCiがこの型を推論できなかったということです。このエラーメッセージで未知の型aと表示されているのがそれです。

::演算子を使って式に対して型注釈を加えると、 PSCiが正しい型クラスインスタンスを選ぶことができるようになります。

> show (Left 10 :: Either Int String)
"(Left 10)"


Showインスタンスをまったく持っていない型もあります。関数の型 ->がその一例です。 Intから Intへの関数を showしようとすると、型検証器によってその通りのエラーメッセージが表示されます。

> import Prelude
> show $ \n -> n + 1

No type class instance was found for

  Data.Show.Show (Int -> Int)


演習

	(簡単)前章の showShape関数を使って、 Shape型に対しての Showインスタンスを定義してみましょう。





6.4 標準的な型クラス

この節では、Preludeや標準ライブラリで定義されている標準的な型クラスをいくつか見ていきましょう。これらの型クラスはPureScript特有の抽象化の基礎としてあちこちで使われているので、これらの関数の基本についてよく理解しておくことを強くお勧めします。

Eq型クラス

Eq型クラスは、2つの値が等しいかどうかを調べるeq関数を定義しています。等値演算子(==)はeqの別名にすぎません。

class Eq a where
  eq :: a -> a -> Boolean


異なる型の2つの値を比較しても意味がありませんから、いずれの演算子も2つの引数が同じ型を持つ必要があることに注意してください。

PSCiで Eq型クラスを試してみましょう。

> 1 == 2
false

> "Test" == "Test"
true


Ord型クラス

Ord型クラスは順序付け可能な型に対して2つの値を比較する compare関数を定義します。 compare関数が定義されていると、比較演算子 <、 >と、その仲間 
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第7章 Applicativeによる検証

7.1 この章の目標

この章では、Applicative型クラスによって表現されるApplicative関手(applicative functor)という重要な抽象化と新たに出会うことになります。名前が難しそうに思えても心配しないでください。フォームデータの検証という実用的な例を使ってこの概念を説明していきます。Applicative関手を使うと、大量の決まり文句を伴うような入力項目の内容を検証するためのコードを、簡潔で宣言的な記述へと変えることができるようになります。

また、Traversable関手(traversable functor)を表現するTraversableという別の型クラスにも出会います。現実の問題への解決策からこの概念が自然に生じるということがわかるでしょう。

この章では第3章に引き続き住所録を例として扱います。今回は住所録のデータ型を拡張し、これらの型の値を検証する関数を書きます。これらの関数は、例えばデータ入力フォームの一部で、使用者へエラーを表示するウェブユーザインタフェースで使われると考えてください。

7.2 プロジェクトの準備

この章のソース·コードは、次のふたつのファイルで定義されています。


	src/Data/AddressBook.purs

	src/Data/AddressBook/Validation.purs



このプロジェクトは多くのBower依存関係を持っていますが、その大半はすでに見てきたものです。新しい依存関係は２つです。


	purescript-control - Applicativeのような型クラスを使用して制御フローを抽象化する関数が定義されています

	purescript-validation - この章の主題である Applicativeによる検証 のための関手が定義されています。



Data.AddressBookモジュールには、このプロジェクトのデータ型とそれらの型に対するShowインスタンスが定義されており、Data.AddressBook.Validationモジュールにはそれらの型の検証規則含まれています。

7.3 関数適用の一般化

Applicative関手の概念を理解するために、まずは以前扱った型構築子Maybeについて考えてみましょう。

このモジュールのソースコードでは、次のような型を持つaddress関数が定義されています。

address :: String -> String -> String -> Address


この関数は、通りの名前、市、州という３つの文字列から型Addressの値を構築するために使います。

この関数は簡単に適用できますので、PSCiでどうなるか見てみましょう。

> import Data.AddressBook

> address "123 Fake St." "Faketown" "CA"
Address { street: "123 Fake St.", city: "Faketown", state: "CA" }


しかし、通り、市、州の三つすべてが必ずしも入力されないものとすると、三つの場合がそれぞれ省略可能であることを示すためにMaybe型を使用したくなります。

考えられる場合としては、市が省略されている場合があるでしょう。もしaddress関数を直接適用しようとすると、型検証器からエラーが表示されます。

> import Data.Maybe
> address (Just "123 Fake St.") Nothing (Just "CA")

Could not match type Maybe String with type String


addressはMaybe String型ではなく文字列型の引数を取るので、もちろんこれは型エラーになります。

しかし、もしaddress関数を「持ち上げる」ことができれば、Maybe型で示される省略可能な値を扱うことができるはずだと期待することは理にかなっています。実際に、Control.Applyで提供されている関数lift3が、まさに求めているものです。

> import Control.Apply
> lift3 address (Just "123 Fake St.") Nothing (Just "CA")

Nothing


このとき、引数のひとつ(市)が欠落していたので、結果はNothingになります。もし3つの引数すべてがJust構築子を使って与えられれば、結果は値を含むことになります。

> lift3 address (Just "123 Fake St.") (Just "Faketown") (Just "CA")
  
Just (Address { street: "123 Fake St.", city: "Faketown", state: "CA" })


lift3という関数の名前は、3引数の関数を持ち上げるために使用できることを示しています。関数を持ち上げる同様の関数で、引数の数が異なるものが、Control.Applyで定義されています。

7.4 任意個の引数を持つ関数の持ち上げ

これで、lift2やlift3のような関数を使えば、引数が2個や3個の関数を持ち上げることができるのはわかりました。でも、これを任意個の引数の関数へと一般化することはできるのでしょうか。

lift3の型を見てみるとわかりやすいでしょう。

> :type lift3
forall a b c d f. Apply f => (a -> b -> c -> d) -> f a -> f b -> f c -> f d


上のMaybeの例では型構築子fはMaybeですから、lift3は次のように特殊化されます。

forall a b c d. (a -> b -> c -> d) -> Maybe a -> Maybe b -> Maybe c -> Maybe d


この型が言っているのは、3引数の任意の関数を取り、その関数を引数と返り値がMaybeで包まれた新しい関数へと持ち上げる、ということです。

もちろんどんな型構築子fについても持ち上げができるわけではないのですが、それではMaybe型を持ち上げができるようにしているものは何なのでしょうか。さて、先ほどの型の特殊化では、fに対する型クラス制約からApply型クラスを取り除いていました。ApplyはPreludeで次のように定義されています。

class Functor f where
  map :: forall a b. (a -> b) -> f a -> f b
class Functor f <= Apply f where
  apply :: forall a b. f (a -> b) -> f a -> f b


Apply型クラスはFunctorの下位クラスであり、追加の関数applyが定義しています。Preludeモジュールでは
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第8章 Effモナド

8.1 この章の目標

第7章では、オプショナルな型やエラーメッセージ、データの検証など、副作用を扱いを抽象化するApplicative関手を導入しました。この章では、より表現力の高い方法で副作用を扱うための別の抽象化、モナドを導入します。

この章の目的は、なぜモナドが便利な抽象化なのか、do記法とどう関係するのかについて説明することです。ブラウザでユーザインターフェイスを構築する副作用を扱うためのある種のモナドを使って、前の章の住所録の例を作ることにしましょう。これから扱うEffモナドは、PureScriptにおけるとても重要なモナドです。Effモナドはいわゆるネイティブな作用をカプセル化するのに使われます。

8.2 プロジェクトの準備

このプロジェクトのソースコードは前の章のソースコードの上に構築しますが、以前のプロジェクトのモジュールは、このプロジェクトの srcディレクトリに含まれています。

このプロジェクトでは、以下のBowerの依存関係が追加されています。


	purescript-eff - Effモナドを提供します。

	purescript-react - Reactユーザインターフェイスへ接続するライブラリを提供します。



前章のモジュールに加えて、この章ではMainモジュールを使用します。このモジュールはエントリポイントであるとともに、UIの描写も行います。

このプロジェクトをコンパイルするには、まずReactをインストールするためnpm installを実行し、それからpulp browserify --to dist/Main.jsでビルドを行います。このプロジェクトを実行するには、html/index.htmlファイルをウェブブラウザで開いてください。

8.3 モナドとdo記法

do記法は配列内包表記を扱うときに最初に導入されました。配列内包表記は Data.Arrayモジュールの concatMap関数の構文糖として提供されています。

次の例を考えてみましょう。２つのサイコロを振って出た目を数え、出た目の合計が nのときそれを得点とすることを考えます。次のような非決定的なアルゴリズムを使うとこれを実現することができます。


	最初の投擲で値 xを選択します。

	２回目の投擲で値 yを選択します。

	もし xと yの和が nなら組 {x, y}を返し、そうでなければ失敗します。



配列内包表記を使うと、この非決定的アルゴリズムを自然に書くことができます。

import Prelude

import Control.Plus (empty)
import Data.Array ((..))

countThrows :: Int -> Array (Array Int)
countThrows n = do
  x <- 1 .. 6
  y <- 1 .. 6
  if x + y == n
    then pure [x, y]
    else empty


PSCiで動作を見てみましょう。

> countThrows 10
[[4,6],[5,5],[6,4]]

> countThrows 12  
[[6,6]]


前の章では、オプショナルな値に対応したより大きなプログラミング言語へとPureScriptの関数を埋め込む、 Maybe Applicative関手についての直感的理解を養いました。同様に配列モナドについても、非決定選択に対応したより大きなプログラミング言語へPureScriptの関数を埋め込む、というような直感的理解を得ることができます。

一般に、ある型構築子 mのモナドは、型 m aの値を持つdo記法を使う方法を提供します。上の配列内包表記では、すべての行に何らかの型 aについての型 Array aの計算が含まれていることに注目してください。一般に、do記法ブロックのすべての行は、何らかの型 aとモナド mについて、型 m aの計算を含んでいます。モナド mはすべての行で同じでなければなりません(つまり、副作用の種類は固定されます)が、型 aは異なることもあります(言い換えると、ここの計算は異なる型の結果を持つことができます)。

型構築子 Maybeが適用された、do記法の別の例を見てみましょう。XMLノードを表す型 XMLと演算子があるとします。

child :: XML -> String -> Maybe XML


この演算子はノードの子の要素を探し、もしそのような要素が存在しなければ Nothingを返します。

この場合、do記法を使うと深い入れ子になった要素を検索することができます。XML文書として符号化された利用者情報から、利用者の住んでいる市町村を読み取りたいとします。

userCity :: XML -> Maybe XML
userCity root = do
  prof <- child root "profile"
  addr <- child prof "address"
  city <- child addr "city"
  pure city


userCity関数は子の要素である profileを探し、 profile要素の中にある address要素、最後に address要素から city要素を探します。これらの要素のいずれかが欠落している場合は、返り値は Nothingになります。そうでなければ、返り値は cityノードから Justを使って構築されています。

最後の行にあるpure関数は、すべてのApplicative関手について定義されているのでした。MaybeのApplicative関手のpure関数はJustとして定義されており、最後の行を Just cityへ変更しても同じように正しく動きます。

8.4 モナド型クラス

Monad型クラスは次のように定義されています。

class Apply m <= Bind m where
  bind :: forall a b. m a -> (a -> m b) -> m b
class (Applicative m, Bind m) <= Monad m


ここで鍵となる関数は Bind型クラスで定義されている演算子 bindで、 Functor及び Apply型クラスにある 
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第9章 キャンバスグラフィックス

9.1 この章の目標

この章のコード例では、PureScriptでHTML5のCanvas APIを使用して2Dグラフィックスを生成する purescript-canvasパッケージに焦点をあててコードを拡張していきます。

9.2 プロジェクトの準備

このモジュールのプロジェクトでは、以下のBowerの依存関係が新しく追加されています。


	purescript-canvas- HTML5のCanvas APIのメソッドの型が定義されています。

	purescript-refs- 大域的な変更可能領域への参照を扱うための副作用を提供しています。



この章のソースコードは、それぞれに mainメソッドが定義されている複数のモ​​ジュールへと分割されています。この章の節の内容はそれぞれ異なるファイルで実装されており、それぞれの節で対応するファイルの mainメソッドを実行できるように、Pulpビルドコマンドを変更することで Mainモジュールが変更できるようになっています。

HTMLファイル html/index.htmlには、各例で使用される単一の canvas要素、およびコンパイルされたPureScriptコードを読み込む script要素が含まれています。各節のコードをテストするには、ブラウザでこのHTMLファイルを開いてください。

9.3 単純な図形

Example/Rectangle.pursファイルにはキャンバスの中心に青い四角形をひとつ描画するという簡単な例が含まれています。このモジュールは、 Control.Monad.Effモジュールと、Canvas APIを扱うための Effモナドのアクションが定義されている Graphics.Canvasモジュールをインポートします。

他のモジュールでも同様ですが、 mainアクションは最初に getCanvasElementByIdアクションを使ってCanvasオブジェクトへの参照を取得しています。また、 getContext2Dアクションを使ってキャンバスの2Dレンダリングコンテキストを参照しています。

main = void $ unsafePartial do
  Just canvas <- getCanvasElementById "canvas"
  ctx <- getContext2D canvas


注意：このunsafePartialの呼び出しは必須です。これは getCanvasElementByIdの結果のパターンマッチングが部分的で、Just値構築子だけと照合するためです。ここではこれで問題ありませんが、実際の製品のコードではおそらくNothing値構築子と照合させ、適切なエラーメッセージを提供したほうがよいでしょう。

これらのアクションの型は、PSCiを使うかドキュメントを見ると確認できます。

getCanvasElementById :: forall eff. String ->
  Eff (canvas :: Canvas | eff) (Maybe CanvasElement)

getContext2D :: forall eff. CanvasElement ->
  Eff (canvas :: Canvas | eff) Context2D


CanvasElementと Context2Dは Graphics.Canvasモジュールで定義されている型です。このモジュールでは、モジュール内のすべてのアクションで使用されている Canvas作用も定義されています。

グラフィックスコンテキスト ctxは、キャンバスの状態を管理し、プリミティブな図形を描画したり、スタイルや色を設定したり、座標変換を適用するためのメソッドを提供しています。

ctxの取得に続けて、 setFillStyleアクションを使って塗りのスタイルを青一色の塗りつぶしに設定しています。

  setFillStyle "#0000FF" ctx


setFillStyleアクションがグラフィックスコンテキストを引数として取っていることに注意してください。これは Graphics.Canvasで共通のパターンです。

最後に、 fillPathアクションを使用して矩形を塗りつぶしています。 fillPathは次のような型を持っています。

fillPath :: forall eff a. Context2D ->
                          Eff (canvas :: Canvas | eff) a ->
                          Eff (canvas :: Canvas | eff) a


fillPathはグラフィックスコンテキストとレンダリングするパスを構築する別のアクションを引数にとります。パスは rectアクションを使うと構築することができます。 rectはグラフィックスコンテキストと矩形の位置及びサイズを格納するレコードを引数にとります。

  fillPath ctx $ rect ctx
    { x: 250.0
    , y: 250.0
    , w: 100.0
    , h: 100.0
    }


mainモジュールの名前としてExample.Rectangleを指定して、この長方形のコード例をビルドしましょう。

$ mkdir dist/
$ pulp build -O --main Example.Rectangle --to dist/Main.js


それでは html/index.htmlファイルを開き、このコードによってキャンバスの中央に青い四角形が描画されていることを確認してみましょう。

9.4 行多相を利用する

パスを描画する方法は他にもあります。 arc関数は円弧を描画します。 moveTo関数、 lineTo関数、 closePath関数は細かい線分を組み合わせることでパスを描画します。

Shapes.pursファイルでは長方形と円弧セグメント、三角形の、3つの図形を描画しています。

rect関数は引数としてレコードをとることを見てきました。実際には、長方形のプロパティは型同義語で定義されています。

type Rectangle = { x :: Number
                 , y :: Number
                 , w :: Number
                 , h :: Number 
                 }


xと yプロパティは左上隅の位置を表しており、 wと hのプロパティはそれぞれ幅と高さを表しています。

arc関数に以下のような型を持つレコードを渡して呼び出すと、円弧を描画することができます。

type Arc = { x     :: Number
           , y     :: Number
           , r     :: Number
           , start :: Number
           , end   :: Number
           }


ここで、 xと yプロパティは弧の中心、 rは半径、 startと endは弧の両端の角度を弧度法で表しています。

たとえば、次のコードは中心 (300、300)、半径 50の円弧を塗りつぶします。

  fillPath ctx $ arc ctx
    { x      : 300.0
    , y      : 300.0
    , r      : 50.0
    , start  : Math.pi * 5.0 / 8.0
    , end    : Math.pi * 2.0
    }


Number型の xと yというプロパティが Rectangleレコード型と Arcレコード型の両方に含まれていることに注意してください。どちらの場合でもこの組は点を表しています。これは、いずれのレコード型にも適用できる、行多相な関数を書くことができることを意味します。

たとえば、 Shapesモジュールでは xと yのプロパティを変更し図形を並行移動する translate関数を定義されています。

translate :: forall r. Number -> Number ->
              { x :: Number, y :: Number | r } ->
              { x :: Number, y :: Number | r }
translate dx dy shape = shape
  { x = shape.x + dx
  , y = shape.y + dy
  }


この行多相型に注目してください。これは triangleが xと yというプロパティと、それに加えて他の任意のプロパティを持ったどんなレコードでも受け入れるということを言っています。 xフィールドと yフィールドは更新されますが、残りのフィールドは変更されません。

これはレコード更新構文の例です。 shape { ... }という式は、 shapeを元にして、括弧の中で指定されたように値が更新されたフィールドを持つ新たなレコードを作ります。波括弧の中の式はレコードリテラルのようなコロンではなく、等号でラベルと式を区切って書くことに注意してください。

Shapesの例からわかるように、 translate関数は Rectangleレコードと Arcレコード双方に対して使うことができます。

Shapeの例で描画される3つめの型は線分ごとのパスです。対応するコードは次のようになります。

  setFillStyle "#FF0000" ctx

  fillPath ctx $ do
    moveTo ctx 300.0 260.0
    lineTo ctx 260.0 340.0
    lineTo ctx 340.0 340.0
    closePath ctx


ここでは3つの関数が使われています。


	moveToはパスの現在位置を指定された座標へ移動させます。

	lineToは現在の位置と指定された座標の間に線分を描画し、現在の位置を更新します。

	closePathは開始位置と現在位置を結ぶ線分を描画し、パスを閉じます。



このコード片を実行すると、二等辺三角形を塗りつぶされます。

mainモジュールとしてExample.Shapesを指定して、この例をビルドしましょう。

$ pulp build -O --main Example.Shapes --to dist/Main.js


そしてもう一度 html/index.htmlを開き、結果を確認してください。キャンバスに３つの異なる図形が描画されるはずです。

演習

	
(簡単) これまでの例のそれぞれについて、 strokePath関数や setStrokeStyle関数を使ってみましょう。



	
(簡単) 関数の引数の内部でdo記法ブロックを使うと、 fillPath関数と strokePath関数で共通のスタイルを持つ複雑なパスを描画することができます。同じ fillPath呼び出しで隣り合った２つの矩形を描画するように、 Rectangleのコード例を変更してみてください。線分と円弧を組み合わせてを、円の扇形を描画してみてください。



	
(やや難しい) 次のような２次元の点を表すレコードが与えられたとします。

type Point = { x :: Number, y :: Number }


多数の点からなる閉じたパスを描く関数 renderPath書いてください。

renderPath :: forall eff. Context2D -> Array Point -> 
                                       Eff (canvas :: Canvas | eff) Unit


次のような関数を考えます。

f :: Number -> Point


この関数は引数として 1から 0の間の Numberをとり、 Pointを返します。 renderPath関数を利用して関数 fのグラフを描くアクションを書いてください。そのアクションは有限個の点を fからサンプリングすることによって近似しなければなりません。

関数 fを変更し、異なるパスが描画されることを確かめてください。







9.5 無作為に円を描く

Example/Random.pursファイルには2種類の異なる副作用が混在した Effモナドを使う例が含まれています。この例では無作為に生成された円をキャンバスに100個描画します。

mainアクションはこれまでのようにグラフィックスコンテキストへの参照を取得し、ストロークと塗りつぶしスタイルを設定します。

  setFillStyle "#FF0000" ctx
  setStrokeStyle "#000000" ctx


次のコードでは forEアクションを使って 0から 100までの整数について繰り返しをしています。

  for_ (1 .. 100) \_ -> do


これらの数は 0から 1の間に無作為に分布しており、それぞれ x座標、 y座標、半径 rを表しています。

    x <- random
    y <- random
    r <- random


次のコードでこれらの変数に基づいて Arcを作成し、最後に現在のスタイルに従って円弧の塗りつぶしと線描が行われます。

    let path = arc ctx
         { x     : x * 600.0
         , y     : y * 600.0
         , r     : r * 50.0
         , start : 0.0
         , end   : Math.pi * 2.0
         }
    fillPath ctx path
    strokePath ctx path


forEに渡された関数が正しい型を持つようにするため、最後の行は必要であることに注意してください。

mainモジュールとしてExample.Randomを指定して、この例をビルドしましょう。

$ pulp build -O --main Example.Random --to dist/Main.js


html/index.htmlを開いて、結果を確認してみましょう。

9.6 座標変換

キャンバスは簡単な図形を描画するだけのものではありません。キャンバスは変換行列を扱うことができ、図形は描画の前に形状を変形してから描画されます。図形は平行移動、回転、拡大縮小、および斜め変形することができます。

purescript-canvasライブラリではこれらの変換を以下の関数で提供しています。

translate :: forall eff. TranslateTransform -> Context2D
                                            -> Eff (canvas :: Canvas | eff) Context2D
rotate    :: forall eff. Number             -> Context2D
                                            -> Eff (canvas :: Canvas | eff) Context2D
scale     :: forall eff. ScaleTransform     -> Context2D
                                            -> Eff (canvas :: Canvas | eff) Context2D
transform :: forall eff. Transform          -> Context2D
                                            -> Eff (canvas :: Canvas | eff) Context2D


translateアクションは TranslateTransformレコードのプロパティで指定した大きさだけ平行移動を行います。

rotateアクションは最初の引数で指定されたラジアンの値に応じて原点を中心とした回転を行います。

scaleアクションは原点を中心として拡大縮小します。 ScaleTransformレコードは X軸と y軸に沿った拡大率を指定するのに使います。

最後の transformはこの４つのうちで最も一般的なアクションです。このアクションは行列に従ってアフィン変換を行います。

これらのアクションが呼び出された後に描画される図形は、自動的に適切な座標変換が適用されます。

実際には、これらの関数のそれぞれの作用は、コンテキストの現在の変換行列に対して変換行列を右から乗算していきます。つまり、もしある作用の変換をしていくと、その作用は実際には逆順に適用されていきます。次のような座標変換のアクションを考えてみましょう。

transformations ctx = do
  translate { translateX: 10.0, translateY: 10.0 } ctx
  scale { scaleX: 2.0, scaleY: 2.0 } ctx
  rotate (Math.pi / 2.0) ctx

  renderScene


このアクションの作用では、まずシーンが回転され、それから拡大縮小され、最後に平行移動されます。

9.7 コンテキストの保存

一般的な使い方としては、変換を適用してシーンの一部をレンダリングし、それからその変換を元に戻します。

Canvas APIにはキャンバスの状態のスタックを操作する saveと restoreメソッドが備わっています。 purescript-canvasではこの機能を次のような関数でラップしています。

save    :: forall eff. Context2D -> Eff (canvas :: Canvas | eff) Context2D
restore :: forall eff. Context2D -> Eff (canvas :: Canvas | eff) Context2D


saveアクションは現在のコンテキストの状態(現在の変換行列や描画スタイル)をスタックにプッシュし、 restoreアクションはスタックの一番上の状態をポップし、コンテキストの状態を復元します。

これらのアクションにより、現在の状態を保存し、いろいろなスタイルや変換を適用し、プリミティブを描画し、最後に元の変換と状態を復元することが可能になります。例えば、次の関数はいくつかのキャンバスアクションを実行しますが、その前に回転を適用し、そのあとに変換を復元します。

rotated ctx render = do
  save ctx
  rotate Math.pi ctx
  render
  restore ctx


こういったよくある使いかたの高階関数を利用した抽象化として、 purescript-canvasライブラリでは元のコンテキスト状態を維持しながらいくつかのキャンバスアクションを実行する withContext関数が提供されています。

withContext :: forall eff a. Context2D -> 
                             Eff (canvas :: Canvas | eff) a ->
                             Eff (canvas :: Canvas | eff) a          


withContextを使うと、先ほどの rotated関数を次のように書き換えることができます。

rotated ctx render = withContext ctx do
    rotate Math.pi ctx
    render


9.8 大域的な変更可能状態

この節では purescript-refsパッケージを使って Effモナドの別の作用について実演してみます。

Control.Monad.Eff.Refモジュールでは大域的に変更可能な参照のための型構築子、および関連する作用を提供します。

> import Control.Monad.Eff.Ref

> :kind Ref
Type -> Type

> :kind REF
Control.Monad.Eff.Effect


型 RefVal aの値は型 a値を保持する変更可能な領域への参照で、前の章で見た STRef h aによく似ています。その違いは、 ST作用は runSTを用いて除去することができますが、 Ref作用はハンドラを提供しないということです。 STは安全に局所的な状態変更を追跡するために使用されますが、 Refは大域的な状態変更を追跡するために使用されます。そのため、 Refは慎重に使用する必要があります。

Example/Refs.pursファイルには canvas要素上のマウスクリックを追跡するのに Ref作用を使用する例が含まれています。

このコー​​ドでは最初に newRefアクションを使って値 0で初期化された領域への新しい参照を作成しています。

  clickCount <- newRef 0


クリックイベントハンドラの内部では、 modifyRefアクションを使用してクリック数を更新しています。

    modifyRef clickCount (\count -> count + 1)


readRefアクションは新しいクリック数を読み取るために使われています。

    count <- readRef clickCount


render関数では、クリック数に応じて変換を矩形に適用しています。

    withContext ctx do
      let scaleX = Math.sin (toNumber count * Math.pi / 4.0) + 1.5
      let scaleY = Math.sin (toNumber count * Math.pi / 6.0) + 1.5

      translate { translateX: 300.0, translateY:  300.0 } ctx
      rotate (toNumber count * Math.pi / 18.0) ctx
      scale { scaleX: scaleX, scaleY: scaleY } ctx
      translate { translateX: -100.0, translateY: -100.0 } ctx

      fillPath ctx $ rect ctx
        { x: 0.0
        , y: 0.0
        , w: 200.0
        , h: 200.0
        }


このアクションでは元の変換を維持するために withContextを使用しており、それから続く変換を順に適用しています(変換が下から上に適用されることを思い出してください)。


	中心が原点に来るように、矩形を (-100, -100)平行移動します。

	矩形を原点を中心に拡大縮小します。

	矩形を原点を中心に 10度の倍数だけ回転します。

	中心がキャンバスの中心に位置するように長方形を (300、300)だけ平行移動します。



このコード例をビルドしてみましょう。

$ pulp build -O --main Example.Refs --to dist/Main.js


html/index.htmlファイルを開いてみましょう。何度かキャンバスをクリックすると、キャンバスの中心の周りを回転する緑の四角形が表示されるはずです。

演習

	
(簡単) パスの線描と塗りつぶしを同時に行う高階関数を書いてください。その関数を使用して Random.purs例を書きなおしてください。



	
(やや難しい)Random作用と DOM作用を使用して、マウスがクリックされたときにキャンバスに無作為な位置、色、半径の円を描画するアプリケーションを作成してください。



	
(やや難しい) シーンを指定された座標を中心に回転する関数を書いてください。ヒント：最初にシーンを原点まで平行移動しましょう。







9.9 L-Systems

この章の最後の例として、 purescript-canvasパッケージを使用してL-systems(Lindenmayer systems)を描画する関数を記述します。

L-Systemsはアルファベット、つまり初期状態となるアルファベットの文字列と、生成規則の集合で定義されています。各生成規則は、アルファベットの文字をとり、それを置き換える文字の配列を返します。この処理は文字の初期配列から始まり、複数回繰り返されます。

もしアルファベットの各文字がキャンバス上で実行される命令と対応付けられていれば、その指示に順番に従うことでL-Systemsを描画することができます。

たとえば、アルファベットが文字 L(左回転)、 R(右回転)、 F(前進)で構成されていたとします。また、次のような生成規則を定義します。

L -> L
R -> R
F -> FLFRRFLF


配列 "FRRFRRFRR" から始めて処理を繰り返すと、次のような経過を辿ります。

FRRFRRFRR
FLFRRFLFRRFLFRRFLFRRFLFRRFLFRR
FLFRRFLFLFLFRRFLFRRFLFRRFLFLFLFRRFLFRRFLFRRFLF...


この命令群に対応する線分パスをプロットすると、コッホ曲線と呼ばれる曲線に近似します。反復回数を増やすと、曲線の解像度が増加していきます。

それでは型と関数の言語へとこれを翻訳してみましょう。

アルファベットの選択肢は型の選択肢によって表すことができます。今回の例では、以下のような型で定義することができます。

data Alphabet = L | R | F


このデータ型では、アルファベットの文字ごとに１つづつデータ構築子が定義されています。

文字の初期配列はどのように表したらいいでしょうか。単なるアルファベットの配列でいいでしょう。これを Sentenceと呼ぶことにします。

type Sentence = Array Alphabet

initial :: Sentence
initial = [F, R, R, F, R, R, F, R, R]


生成規則は Alphabetから Sentenceへの関数として表すことができます。

productions :: Alphabet -> Sentence
productions L = [L]
productions R = [R]
productions F = [F, L, F, R, R, F, L, F]


これはまさに上記の仕様をそのまま書き写したものです。

これで、この形式の仕様を受け取りキャンバスに描画する関数 lsystemを実装することができます。 lsystemはどのような型を持っているべきでしょうか。この関数は初期状態 initialと生成規則 productionsのような値だけでなく、アルファベットの文字をキャンバスに描画する関数を引数に取る必要があります。

lsystemの型の最初の大まかな設計としては、次のようになるかもしれません。

forall eff. Sentence
         -> (Alphabet -> Sentence)
         -> (Alphabet -> Eff (canvas :: Canvas | eff) Unit)
         -> Int
         -> Eff (canvas :: Canvas | eff) Unit


最初の2つの引数の型は、値 initialと productionsに対応しています。

3番目の引数は、アルファベットの文字を取り、キャンバス上のいくつかのアクションを実行することによって翻訳する関数を表します。この例では、文字 Lは左回転、文字 Rで右回転、文字 Fは前進を意味します。

最後の引数は、実行したい生成規則の繰り返し回数を表す数です。

最初に気づくことは、現在の lsystem関数は Alphabet型だけで機能しますが、どんなアルファベットについても機能すべきですから、この型はもっと一般化されるべきです。それでは、量子化された型変数 aについて、 Alphabetと Sentenceを aと Array aで置き換えましょう。

forall a eff. Array a
           -> (a -> Array a)
           -> (a -> Eff (canvas :: Canvas | eff) Unit)
           -> Int
           -> Eff (canvas :: Canvas | eff) Unit


次に気付くこととしては、「左回転」と「右回転」のような命令を実装するためには、いくつかの状態を管理する必要があります。具体的に言えば、その時点でパスが向いている方向を状態として持たなければなりません。計算を通じて状態を関数に渡すように変更する必要があります。ここでも lsystem関数は状態がどんな型でも動作しなければなりませんから、型変数 sを使用してそれを表しています。

型 sを追加する必要があるのは3箇所で、次のようになります。

forall a s eff. Array a
             -> (a -> Array a)
             -> (s -> a -> Eff (canvas :: Canvas | eff) s)
             -> Int
             -> s
             -> Eff (canvas :: Canvas | eff) s


まず追加の引数の型として lsystemに型 sが追加されています。この引数はL-Systemの初期状態を表しています。

型 sは引数にも現れますが、翻訳関数(lsystemの第3引数)の返り値の型としても現れます。翻訳関数は今のところ、引数としてL-Systemの現在の状態を受け取り、返り値として更新された新しい状態を返します。

この例の場合では、次のような型を使って状態を表す型を定義することができます。

type State =
  { x :: Number
  , y :: Number
  , theta :: Number
  }


プロパティ xと yはパスの現在の位置を表しており、プロパティ thetaは現在の向きを表しており、ラジアンで表された水平線に対するパスの角度です。

システムの初期状態としては次のようなものが考えられます。

initialState :: State
initialState = { x: 120.0, y: 200.0, theta: 0.0 }


それでは、 lsystem関数を実装してみます。定義はとても単純であることがわかるでしょう。

lsystemは第４引数の値(型 Number)に応じて再帰するのが良さそうです。再帰の各ステップでは、生成規則に従って状態が更新され、現在の文が変化していきます。このことを念頭に置きつつ、まずは関数の引数の名前を導入して、補助関数に処理を移譲することから始めましょう。

lsystem :: forall a s eff. Array a
        -> (a -> Array a)
        -> (s -> a -> Eff (canvas :: Canvas | eff) s)
        -> Int
        -> s
        -> Eff (canvas :: Canvas | eff) s
lsystem init prod interpret n state = go init n
  where


go関数は第2引数に応じて再帰することで動きます。 nがゼロであるときと nがゼロでないときの2つの場合で分岐します。

nがゼロの場合では再帰は完了し、解釈関数に応じて現在の文を解釈します。ここでは引数として与えられている、


	型 Array aの文

	型 sの状態

	型 s -> a -> Eff (canvas :: Canvas | eff) sの関数



を参照することができます。これらの引数の型を考えると、以前定義した foldMの呼び出しにちょうど対応していることがわかります。 foldMは purescript-controlパッケージでも定義されています。

  go s 0 = foldM interpret state s


ゼロでない場合ではどうでしょうか。その場合は、単に生成規則を現在の文のそれぞれの文字に適用して、その結果を連結し、そしてこの処理を再帰します。

  go s n = go (concatMap prod s) (n - 1)


これだけです！foldMや concatMapのような高階関数を使うと、このようにアイデアを簡潔に表現することができるのです。

しかし、まだ完全に終わったわけではありません。ここで与えた型は、実際はまだ特殊化されすぎています。この定義ではキャンバスの操作が実装のどこにも使われていないことに注目してください。それに、まったく Effモナドの構造を利用していません。実際には、この関数はどんなモナド mについても動作するのです！

この章に添付されたソースコードで定義されている、 lsystemのもっと一般的な型は次のようになっています。

lsystem :: forall a m s . Monad m =>
           Array a
        -> (a -> Array a)
        -> (s -> a -> m s)
        -> Int
        -> s
        -> m s


この型が言っているのは、この翻訳関数はモナド mで追跡される任意の副作用をまったく自由に持つことができる、ということだと理解することができます。キャンバスに描画したり、またはコンソールに情報を出力するかもしれませんし、失敗や複数の戻り値に対応しているかもしれません。こういった様々な型の副作用を使ったL-Systemを記述してみることを読者にお勧めします。

この関数は実装からデータを分離することの威力を示す良い例となっています。この手法の利点は、複数の異なる方法でデータを解釈する自由が得られることです。 lsystemは２つの小さな関数へと分解することができるかもしれません。ひとつめは concatMapの適用の繰り返しを使って文を構築するもので、ふたつめは foldMを使って文を翻訳するものです。これは読者の演習として残しておきます。

それでは翻訳関数を実装して、この章の例を完成させましょう​​。 lsystemの型は型シグネチャが言っているのは、翻訳関数の型は、何らかの型 aと s、型構築子 mについて、 s -> a -> m sでなければならないということです。今回は aを Alphabet、 sを State、モナド mを Eff (canvas :: Canvas)というように選びたいということがわかっています。これにより次のような型になります。

interpret :: State -> Alphabet -> Eff (canvas :: Canvas) State


この関数を実装するには、 Alphabet型の3つのデータ構築子それぞれについて処理する必要があります。文字 L(左回転)と R(右回転)の解釈では、 thetaを適切な角度へ変更するように状態を更新するだけです。

interpret state L = pure $ state { theta = state.theta - Math.pi / 3 }
interpret state R = pure $ state { theta = state.theta + Math.pi / 3 }


文字 F(前進)を解釈するには、パスの新しい位置を計算し、線分を描画し、状態を次のように更新します。

interpret state F = do
  let x = state.x + Math.cos state.theta * 1.5
      y = state.y + Math.sin state.theta * 1.5
  moveTo ctx state.x state.y
  lineTo ctx x y
  pure { x, y, theta: state.theta }


この章のソースコードでは、名前 ctxを参照できるようにするために、 interpret関数は main関数内で let束縛を使用して定義されていることに注意してください。 State型がコンテキストを持つように変更することは可能でしょうが、それはこのシステムの状態の変化部分ではないので不適切でしょう。

このL-Systemsを描画するには、次のような strokePathアクションを使用するだけです。

strokePath ctx $ lsystem initial productions interpret 5 initialState


L-Systemをコンパイルし、

$ pulp build -O --main Example.LSystem --to dist/Main.js


html/index.htmlを開いてみましょう。キャンバスにコッホ曲線が描画されるのがわかると思います。

演習

	
(簡単)strokePathの代わりに fillPathを使用するように、上のL-Systemsの例を変更してください。ヒント：closePathの呼び出しを含め、 moveToの呼び出しを interpret関数の外側に移動する必要があります。



	
(簡単) 描画システムへの影響を理解するために、コード中の様々な数値の定数を変更してみてください。



	
(やや難しい)lsystem関数を2つの小さな関数に分割してください。ひとつめは concatMapの適用の繰り返しを使用して最終的な結果を構築するもので、ふたつめは foldMを使用して結果を解釈するものでなくてはなりません。



	
(やや難しい)setShadowOffsetXアクション、 setShadowOffsetYアクション、 setShadowBlurアクション、 setShadowColorアクションを使い、塗りつぶされた図形にドロップシャドウを追加してください。ヒント：PSCiを使って、これらの関数の型を調べてみましょう。



	
(やや難しい) 向きを変えるときの角度の大きさは今のところ一定(pi/3)です。その代わりに、 Alphabetデータ型の中に角度の大きさを追加して、生成規則によって角度を変更できるようにしてください。

type Angle = Number

data Alphabet = L Angle | R Angle | F Angle


生成規則でこの新しい情報を使うと、どんな面白い図形を作ることができるでしょうか。



	
(難しい)L(60度左回転 )、 R(60度右回転)、 F(前進)、 M(これも前進)という４つの文字からなるアルファベットでL-Systemが与えられたとします。

このシステムの文の初期状態は、単一の文字 Mです。

このシステムの生成規則は次のように指定されています。

L -> L
R -> R
F -> FLMLFRMRFRMRFLMLF
M -> MRFRMLFLMLFLMRFRM


このL-Systemを描画してください。注意：最後の文のサイズは反復回数に従って指数関数的に増大するので、生成規則の繰り返しの回数を削減することが必要になります。

ここで、生成規則における Lと Mの間の対称性に注目してください。ふたつの「前進」命令は、次のようなアルファベット型を使用すると、 Boolean値を使って区別することができます。

data Alphabet = L | R | F Boolean


このアルファベットの表現を使用して、もう一度このL-Systemを実装してください。



	
(難しい) 翻訳関数で別のモナド mを使ってみましょう。 Trace作用を利用してコンソール上にL-Systemを出力したり、 Random作用を利用して状態の型に無作為の突然変異を適用したりしてみてください。







まとめ

この章では、 purescript-canvasライブラリを使用することにより、PureScriptからHTML5 Canvas APIを使う方法について学びました。マップや畳み込み、レコードと行多型、副作用を扱うための Effモナドなど、これまで学んできた手法を利用した実用的な例について多く見ました。

この章の例では、高階関数の威力を示すとともに、実装からのデータの分離も実演してみせました。これは例えば、代数データ型を使用してこれらの概念を次のように拡張し、描画関数からシーンの表現を完全に分離できるようになります。

data Scene = Rect Rectangle
           | Arc Arc
           | PiecewiseLinear (Array Point)
           | Transformed Transform Scene
           | Clipped Rectangle Scene
           | ...


この手法は purescript-drawingパッケージでも採用されており、描画前にさまざまな方法でデータとしてシーンを操作することができるという柔軟性をもたらしています。

次の章では、PureScriptの外部関数インタフェース(foreign function interface)を使って、既存のJavaScriptの関数をラップした purescript-canvasのようなライブラリを実装する方法について説明します。
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chapter10
第10章 外部関数インタフェース

10.1 この章の目標

この章では、PureScriptコードからJavaScriptコードへの呼び出し、およびその逆を可能にする、PureScriptの外部関数インタフェース(foreign function interface, FFI)を紹介します。これから扱うのは次のようなものです。


	PureScriptから純粋なJavaScript関数を呼び出す方法

	既存のJavaScriptコードに基づいて、作用型と Effモナドと一緒に使用する新しいアクションを作成する方法

	JavaScriptからPureScriptコードを呼び出す方法

	実行時のPureScriptの値の表現を知る方法

	purescript-foreignパッケージを使用して型付けされていないデータを操作する方法



この章の終わりにかけて、再び住所録のコード例について検討します。この章の目的は、FFIを使ってアプリケーションに次のような新しい機能を追加することです。


	ポップアップ通知でユーザーに警告する

	フォームのデータを直列化してブラウザのローカルストレージに保存し、アプリケーションが再起動したときにそれを再読み込みする



10.2 プロジェクトの準備

このモジュールのソースコードは、第3章、第7章及び第8章の続きになります。今回もそれぞれのディレクトリから適切なソースファイルがソースファイルに含められています。

この章では、2つの新しいBower依存関係を追加します。


	purescript-foreign- データ型と関数を提供しています。

	purescript-foreign-generic- データ型ジェネリックプログラミングを操作するためのデータ型と関数を提供します。



注意：ウェブページがローカルファイルから配信されているときに起こる、ローカルストレージとブラウザ特有の問題を避けるために、この章の例を実行するには、HTTPを経由してこの章のプロジェクトを実行する必要があります。

10.3 免責事項

JavaScriptとの共同作業をできる限り簡単にするため、PureScriptは単純な多言語関数インタフェースを提供します。しかしながら、FFIはPureScriptの高度な機能であることには留意していただきたいと思います。FFIを安全かつ効率的に使用するには、扱うつもりであるデータの実行時の表現についてよく理解していなければなりません。この章では、PureScriptの標準ライブラリのコードに関連する、そのような理解を与えることを目指しています。

PureScriptのFFIはとても柔軟に設計されています。実際には、外部関数に最低限の型だけを与えるか、それとも型システムを利用して外部のコードの誤った使い方を防ぐようにするか、開発者が選ぶことができるということを意味しています。標準ライブラリのコードは、後者の手法を好む傾向にあります。

簡単な例としては、JavaScriptの関数で戻り値が nullをされないことを保証することはできません。実のところ、既存のJavaScriptコードはかなり頻繁に nullを返します！しかし、PureScriptの型は通常null値を持っていません。そのため、FFIを使ってJavaScriptコードのインターフェイスを設計するときは、これらの特殊な場合を適切に処理するのは開発者の責任です。

10.4 JavaScriptからPureScriptを呼び出す

少なくとも単純な型を持った関数については、JavaScriptからPureScript関数を呼び出すのはとても簡単です。

例として以下のような簡単なモジュールを見てみましょう。

module Test where

gcd :: Int -> Int -> Int
gcd 0 m = m
gcd n 0 = n
gcd n m
  | n > m     = gcd (n - m) m
  | otherwise = gcd (m - n) n


この関数は、減算を繰り返すことによって2つの数の最大公約数を見つけます。関数を定義するのにPureScriptを使いたくなるかもしれない良い例となっていますが、JavaScriptからそれを呼び出すためには条件があります。
PureScriptでパターン照合と再帰を使用してこの関数を定義するのは簡単で、実装する開発者は型検証器の恩恵を受けることができます。

この関数をJavaScriptから呼び出す方法を理解するには、PureScriptの関数は常に引数がひとつのJavaScript関数へと変換され、引数へは次のようにひとつづつ適用していかなければならないことを理解するのが重要です。

var Test = require('Test');
Test.gcd(15)(20);


ここでは、コードがPureScriptモジュールをCommonJSモジュールにコンパイルする pulp buildでコンパイルされていると仮定しています。 そのため、 requireを使って Testモジュールをインポートした後、 Testオブジェクトの gcd関数を参照することができました。

pulp build -O --to file.jsを使用して、ブラウザ用のJavaScriptコードをバンドルすることもできます。 その場合、グローバルなPureScript名前空間から Testモジュールにアクセスします。デフォルトは PSです。

var Test = PS.Test;
Test.gcd(15)(20);


10.5 名前の生成を理解する

PureScriptはコード生成時にできるだけ名前を保存することを目的としています。具体的には、トップレベルでの宣言では、JavaScriptのキーワードでなければ任意の識別子が保存されます。

識別子としてJavaScriptの予約語を使う場合は、名前はダブルダラー記号でエスケープされます。たとえば、次のPureScriptコードを考えてみます。

null = []


これは以下のようなJavaScriptへコンパイルされます。

var $$null = [];


また、識別子に特殊文字を使用したい場合は、単一のドル記号を使用してエスケープされます。たとえば、このPureScriptコードを考えます。

example' = 100


これは以下のJavaScriptにコンパイルされます。

var example$prime = 100;


この方式は、ユーザー定義の中置演算子の名前を生成するためにも使用されます。

(%) a b = ...


これは次のようにコンパイルされます。

var $percent = ...


コンパイルされたPureScriptコードがJavaScriptから呼び出されることを意図している場合、識別子は英数字のみを使用し、JavaScriptの予約語を避けることをお勧めします。ユーザ定義演算子がPureScriptコードでの使用のために提供される場合でも、JavaScriptから使うための英数字の名前を持った代替関数を提供しておくことをお勧めします。

10.6 実行時のデータ表現

型はプログラムがある意味で「正しい」ことをコンパイル時に判断できるようにします。つまり、実行時には中断されません。しかし、これは何を意味するのでしょうか？PureScriptでは式の型は実行時の表現と互換性がなければならないことを意味します。

そのため、PureScriptとJavaScriptコードを一緒に効率的に使用できるように、実行時のデータ表現について理解することが重要です。これは、与えられた任意のPureScriptの式について、その値が実行時にどのように評価されるかという挙動を理解できるべきであることを意味しています。

PureScriptの式は、実行時に特に単純な表現を持っているということは朗報です。実際に標準ライブラリのコードについて、その型を考慮すれば式の実行時のデータ表現を把握することが可能です。

単純な型については、対応関係はほとんど自明です。たとえば、式が型 Booleanを持っていれば、実行時のその値 vは typeof v === 'boolean'を満たします。つまり、型 Booleanの式は trueもしくは falseのどちらか一方の(JavaScriptの)値へと評価されます。実のところ、 nullや undefinedに評価される、型 BooleanのPureScriptの式はありません。

Numberと Stringの型の式についても同様のことが成り立ちます。 Number型の式は nullでないJavaScriptの数へと評価されますし、 String型の式は nullでないJavaScriptの文字列へと評価されます。

もっと複雑な型についてはどうでしょうか？

すでに見てきたように、PureScriptの関数は引数がひとつのJavaScriptの関数に対応しています。厳密に言えば、任意の型 a、 bについて、式 fの型が a -> bで、式 xが型 aについての適切な実行時表現の値へと評価されるなら、 fはJavaScriptの関数へと評価され、 xを評価した結果に fを適用すると、それは型 bの適切な実行時表現を持ちます。簡単な例としては、 String -> String型の式は、 nullでないJavaScript文字列から nullでないJavaScript文字列への関数へと評価されます。

ご想像のとおり、PureScriptの配列はJavaScriptの配列に対応しています。しかし、PureScriptの配列は均質であり、つまりすべての要素が同じ型を持っていることは覚えておいてください。具体的には、もしPureScriptの式 eが任意の型 aについて型 Array aを持っているなら、 eはすべての要素が型 aの適切な実行時表現を持った(nullでない)JavaScript配列へと評価されます。

PureScriptのレコードがJavaScriptのオブジェクトへと評価されることはすでに見てきました。ちょうど関数と配列の場合のように、そのラベルに関連付けられている型を考慮すれば、レコードのフィールドのデータの実行時の表現についても推論することができます。もちろん、レコードのそれぞれのフィールドは、同じ型である必要はありません。

10.7 代数的データ型の実行時表現

PureScriptコンパイラは、代数的データ型のすべての構築子についてそれぞれ関数を定義し、新たなJavaScriptオブジェクト型を作成します。これらの構築子はこれらのプロトタイプに基づいて新しいJavaScriptオブジェクトを作成する関数に対応しています。

たとえば、次のような単純な代数的データ型を考えてみましょう。

data ZeroOrOne a = Zero | One a


PureScriptコンパイラは、次のようなコードを生成します。

function One(value0) {
    this.value0 = value0;
};

One.create = function (value0) {
    return new One(value0);
};

function Zero() {
};

Zero.value = new Zero();


ここで2つのJavaScriptオブジェクト型 Zeroと Oneを見てください。JavaScriptの予約語 newを使用すると、それぞれの型の値を作成することができます。引数を持つ構築子については、コンパイラは value0、 value1などと呼ばれるフィールドに対応するデータを格納します。

PureScriptコンパイラは補助関数も生成します。引数のない構築子については、コンパイラは構築子が使われるたびに new演算子を使うのではなく、データを再利用できるように valueプロパティを生成します。ひとつ以上の引数を持つ構築子では、適切な表現を持つ引数を取り適切な構築子を適用する create関数をコンパイラは生成します。

２引数以上の構築子についてはどうでしょうか？その場合でも、PureScriptコンパイラは新しいオブジェクト型と補助関数を作成します。しかし今回は、補助関数は2引数のカリー化された関数です。たとえば、次のような代数的データ型を考えます。

data Two a b = Two a b


このコードからは、次のようなJavaScriptコードを生成されます。

function Two(value0, value1) {
    this.value0 = value0;
    this.value1 = value1;
};

Two.create = function (value0) {
    return function (value1) {
        return new Two(value0, value1);
    };
};


ここで、オブジェクト型 Twoの値は予約語 newまたは Two.create関数を使用すると作成することができます。

newtypeの場合はまた少し異なります。newtypeは単一の引数を取る単一の構築子を持つよう制限された代数的データ型であることを思い出してください。この場合には、実際はnewtypeの実行時表現は、その引数の型と同じになります。

例えば、電話番号を表す次のようなnewtypeを考えます。

newtype PhoneNumber = PhoneNumber String


これは実行時にはJavaScriptの文字列として表されます。newtypeは型安全性の追加の層を提供しますが、実行時の関数呼び出しのオーバーヘッドがないので、ライブラリを設計するのに役に立ちます。

10.8 量化された型の実行時表現

量化された型(多相型)の式は、制限された表現を実行時に持っています。実際には、量化された型の式が比較的少数与えられたとき、とても効率的に解決できることを意味しています。

例えば、次の多相型を考えてみます。

forall a. a -> a


この型を持っている関数にはどんなものがあるでしょうか。少なくともひとつはこの型を持つ関数が存在しています。すなわち、 Preludeで定義されている恒等関数 idです。

id :: forall a. a -> a
id a = a


実のところ、 idの関数はこの型の唯一の(全)関数です！これは確かに間違いなさそうに見えますが(この型を持った idとは明らかに異なる式を書こうとしてみてください)、これを確かめるにはどうしたらいいでしょうか。これは型の実行時表現を考えることによって確認することができます。

量化された型 forall a. tの実行時表現はどうなっているのでしょうか。さて、この型の実行時表現を持つ任意の式は、型 aをどのように選んでも型 tの適切な実行時表現を持っていなければなりません。上の例では、型 forall a. a -> aの関数は、 String -> String、 Number -> Number、 Array Boolean -> Array Booleanなどといった型について、適切な実行時表現を持っていなければなりません。 これらは、数から数、文字列から文字列の関数でなくてはなりません。

しかし、それだけでは十分ではありません。量化された型の実行時表現は、これよりも更に厳しくなります。任意の式がパラメトリック多相的でなければなりません。つまり、その実装において、引数の型についてのどんな情報も使うことができないのです。この追加の条件は、考えられる多相型のうち、次のようなJavaScriptの関数として問題のある実装を禁止します。

function invalid(a) {
    if (typeof a === 'string') {
        return "Argument was a string.";
    } else {
        return a;
    }
}


確かにこの関数は文字列から文字列、数から数へというような関数ではありますが、追加の条件を満たしていません。引数の実行時の型を調べているからです。したがって、この関数は型 forall a. a -> aの正しい実装だとはいえないのです。

関数の引数の実行時の型を検査することができなければ、唯一の選択肢は引数をそのまま返すことだけであり、したがって idは、 forall a. a -> aのまったく唯一の実装なのです。

パラメトリック多相(parametric polymorphism)とパラメトリック性(parametricity)についての詳しい議論は本書の範囲を超えています。しかしながら、PureScriptの型は、実行時に消去されているので、PureScriptの多相関数は(FFIを使わない限り)引数の実行時表現を検査することができないし、この多相的なデータの表現は適切であることに注意してください。

10.9 制約された型の実行時表現

型クラス制約を持つ関数は、実行時に面白い表現を持っています。関数の振る舞いはコンパイラによって選ばれた型クラスのインスタンスに依存する可能性があるため、関数には選択したインスタンスから提供された型クラスの関数の実装が含まれてた型クラス辞書(type class dictionary)と呼ばれる追加の引数が与えられています。

例えば、 Show型クラスを使用している制約された型を持つ、次のような単純なPureScript関数について考えます。

shout :: forall a. Show a => a -> String
shout a = show a <> "!!!"


このコードから生成されるJavaScriptは次のようになります。

var shout = function (dict) {
    return function (a) {
        return show(dict)(a) + "!!!";
    };
};


shoutは１引数ではなく、２引数の(カリー化された)関数にコンパイルされていることに注意してください。最初の引数 dictは Show制約の型クラス辞書です。 dictには型 aの show関数の実装が含まれています。

最初の引数として明示的にPreludeの型クラス辞書を渡すと、JavaScriptからこの関数を呼び出すことができます。

shout(require('Prelude').showNumber)(42);


演習

	
(簡単) これらの型の実行時の表現は何でしょうか。

forall a. a
forall a. a -> a -> a
forall a. Ord a => Array a -> Boolean


これらの型を持つ式についてわかることはなんでしょうか。



	
(やや難しい)pulp buildを使ってコンパイルし、NodeJSの require関数を使ってモジュールをインポートすることで、JavaScriptから purescript-arraysライブラリの関数を使ってみてください。ヒント：生成されたCommonJSモジュールがNodeJSモジュールのパスで使用できるように、出力パスを設定する必要があります。







10.10 PureScriptからのJavaScriptコードを使う

PureScriptからJavaScriptコードを使用する最も簡単な方法は、外部インポート宣言(foreign import declaration)を使用し、既存のJavaScriptの値に型を与えることです。外部インポート宣言では、対応するJavaScriptの宣言を外部JavaScriptモジュール(foreign JavaScript module)に持つ必要があります。

たとえば、特殊文字をエスケープすることによりURIのコンポーネントを符号化するJavaScriptの encodeURIComponent関数について考えてみます。

$ node

node> encodeURIComponent('Hello World')
'Hello%20World'


nullでない文字列から nullでない文字列への関数であり、副作用を持っていないので、この関数はその型 String -> Stringについて適切な実行時表現を持っています。

次のような外部インポート宣言を使うと、この関数に型を割り当てることができます。

module Data.URI where

foreign import encodeURIComponent :: String -> String


また、外部JavaScriptモジュールを書く必要があります。上記のモジュールをsrc/Data/URI.pursとして保存した場合、次のような外部JavaScriptモジュールをsrc/Data/URI.jsとして保存します。

"use strict";

exports.encodeURIComponent = encodeURIComponent;


Pulpはsrcディレクトリにある.jsファイルを見つけ、それを外部JavaScriptモジュールとしてコンパイラに提供します。

JavaScriptの関数と値は、通常のCommonJSモジュールと同じようにexportsオブジェクトに代入することで、外部JavaScriptモジュールからエクスポートされます。pursコンパイラは、このモジュールを通常のCommonJSモジュールのように扱い、コンパイルされたPureScriptモジュールへの依存関係として追加します。しかし、psc-bundleやpulp build -O --toを使ってブラウザ向けのコードをバンドルするときは、上記のパターンに従い、プロパティ代入を使ってexportsオブジェクトにエクスポートする値を代入することがとても重要です。 これは、psc-bundleがこの形式を認識し、未使用のJavaScriptのエクスポートをバンドルされたコードから削除できるようにするためです。

これら2つの部品を使うことで、PureScriptで書かれた関数のように、PureScriptからencodeURIComponent関数を使うことができます。たとえば、この宣言をモジュールとして保存してPSCiにロードすると、上記の計算を再現できます。

$ pulp repl

> import Data.URI
> encodeURIComponent "Hello World"
"Hello%20World"


この手法は簡単なJav​​aScriptの値には適していますが、もっと複雑な値に使うには限界があります。ほとんどの既存のJavaScriptコードは、基本的なPureScriptの型の実行時表現によって課せられた厳しい条件を満たしていないからです。このような場合のためには、適切な実行時表現に従うことを強制するようにJavaScriptコードをラップするという別の方法があります。

10.11 JavaScriptの値のラッピング

これはPureScriptの型を与えるためにJavaScriptコードの既存の部分をラップする場合に特に便利です。このようにしたくなる理由はいくつかあります。


	関数が複数の引数を取るが、カリー化した関数と同じように呼び出したい。

	任意のJavaScriptの副作用を追跡するために、 Effモナドを使うことができます。

	関数の適切な実行時表現を与えるために、 nullや undefinedのような特殊な場合を処理するために必要な場合があります。



外部インポート宣言を使用して、配列についての head関数を作成したいとしましょう。JavaScriptでは次のような関数になるでしょう。

function head(arr) {
    return arr[0];
}


しかし、この関数には問題があります。型 forall a. Array a -> aを与えようとしても、空の配列に対してこの関数は undefinedを返します。したがって、この特殊な場合を処理するために、ラッパー関数を使用する必要があります。

簡単な方法としては、空の配列の場合に例外を投げる方法があります。厳密に言えば、純粋な関数は例外を投げるべきではありませんが、デモンストレーションの目的ではこれで十分ですし、安全性でないということを関数名で示しておけばいいでしょう。

foreign import unsafeHead :: forall a. Array a -> a


JavaScriptモジュールでは、 unsafeHeadを以下のように定義することができます。

exports.unsafeHead = function(arr) {
  if (arr.length) {
    return arr[0];
  } else {
    throw new Error('unsafeHead: empty array');
  }
};


10.12 外部型の定義

失敗した場合に例外を投げるという方法は、あまり理想的とはいえません。PureScriptのコードでは、欠けた値のような副作用は型システムを使って扱うのが普通です。この手法としては Maybe型構築子を使う方法もありますが、この節ではFFIを使用した別の解決策を扱います。

実行時には型 aのように表現されますが undefinedの値も許容するような新しい型 Undefined aを定義したいとしましょう。

外部インポート宣言とFFIを使うと、外部型(foreign type)を定義することができます。構文は外部関数を定義するのと似ています。

foreign import data Undefined :: Type -> Type


この予約語 dataは値ではなく定義している型を表していることに注意してください。型シグネチャの代わりに、新しい型の種を与えます。このとき、種 Undefinedが Type -> Typeであると宣言しています。つまり Undefinedは型構築子です。

これで headの定義を簡素化することができます。

exports.head = function(arr) {
  return arr[0];
};


PureScriptモジュールには以下を追加します。

foreign import head :: forall a. Array a -> Undefined a


2点変更がある注意してください。 head関数の本体ははるかに簡単で、もしその値が未定義であったとしても arr[0]を返し、型シグネチャはこの関数が未定義の値を返すことがあるという事実を反映するよう変更されています。

この関数はその型の適切な実行時表現を持っていますが、型 Undefined aの値を使用する方法がありませんので、まったく役に立ちません。しかし、FFIを使用して新しい関数を幾つか書くことによって、それを修正することができます！

次の関数は、値が定義されているかどうかを教えてくれる最も基本的な関数です。

foreign import isUndefined :: forall a. Undefined a -> Boolean


JavaScriptモジュールで次のように簡単に定義できます。

exports.isUndefined = function(value) {
  return value === undefined;
};


PureScriptから isUndefinedと headを一緒に使用すると、便利な関数を定義することができます。

isEmpty :: forall a. Array a -> Boolean
isEmpty = isUndefined <<< head


ここで、定義されたこの外部関数はとても簡単であり、PureScriptの型検査器を使うことによる利益をなるべく多く得るということを意味します。一般に外部関数は可能な限り小さく保ち、アプリケーションの処理はPureScriptコードへ移動しておくことをおすすめします。

10.13 多変数​関数

PureScriptのPreludeには、興味深い外部型がいくつかも含まれています。すでに扱ってきたように、PureScriptの関数型は単一の引数だけを取りますが、カリー化(Currying)を使うと複数の引数の関数をシミュレートすることができます。これには明らかな利点があります。関数を部分適用することができ、関数型の型クラスインスタンスを与えることができます。ただし、効率上のペナルティが生じます。パフォーマンス重視するコードでは、複数の引数を受け入れる本物のJavaScript関数を定義することが必要な場合があります。Preludeではそのような関数を安全に扱うことができるようにする外部型が定義されています。

たとえば、Preludeの Data.Function.Uncurriedモジュールには次の外部型宣言があります。

foreign import data Fn2 :: Type -> Type -> Type -> Type


これは3つの型引数を取る型構築子 Fn2を定義します。 Fn2 a b cは、型 aと bの２つの引数、返り値の型 cをもつJavaScript関数の型を表現しています。

Preludeでは0引数から10引数までの関数について同様の型構築子が定義されています。

次のように mkFn2関数を使うと、2引数の関数を作成することができます。

import Data.Function.Uncurried

divides :: Fn2 Int Int Boolean
divides = mkFn2 \n m -> m % n == 0


そして、 runFn2関数を使うと、2引数の関数を適用することができます。

> runFn2 divides 2 10
true

> runFn2 divides 3 10
false


ここで重要なのは、引数がすべて適用されるなら、コンパイラは mkFn2関数や runFn2関数をインライン化するということです。そのため、生成されるコードはとてもコンパクトになります。

exports.divides = function(n, m) {
    return m % n === 0;
};


10.14 副作用の表現

EffモナドもPreludeの外部型として定義されています。その実行時表現はとても簡単です。型 Eff eff aの式は、任意の副作用を実行し型 aの適切な実行時表現で値を返す、引数なしのJavaScript関数へと評価されます。

Eff型の構築子の定義は、 Control.Monad.Effモジュールで次のように与えられています。

foreign import data Eff :: # Effect -> Type -> Type


Eff型の構築子は作用の行と返り値の型によってパラメータ化されおり、それが種に反映されることを思い出してください。

簡単な例として、 purescript-randomパッケージで定義される random関数を考えてみてください。その型は次のようなものでした。

foreign import random :: forall eff. Eff (random :: RANDOM | eff) Number


random関数の定義は次のように与えられます。

exports.random = function() {
  return Math.random();
};


random関数は実行時には引数なしの関数として表現されていることに注目してください。これは乱数生成という副作用を実行しそれを返しますが、返り値は Number型の実行時表現と一致します。それは nullでないJavaScriptの数です。

もう少し興味深い例として、 Preludeの Control.Monad.Eff.Consoleモジュールで定義された log関数を考えてみましょう。 log関数は次の型を持っています。

foreign import log :: forall eff. String -> Eff (console :: CONSOLE | eff) Unit


この定義は次のようになっています。

exports.log = function (s) {
  return function () {
    console.log(s);
  };
};


実行時の logの表現は、引数なしの関数を返す、単一の引数のJavaScript関数です。内側の関数はコンソールにメッセージを書き込むという副作用を実行し、空のレコードを返します。 Unitは空のレコード型のnewtypeとしてPreludeで定義されているので、内側の関数の戻り値の型は Unit型の実行時表現と一致していることに注意してください。

作用 RANDOMと CONSOLEも外部型として定義されています。その種は !、つまり作用であると定義されています。例えば次のようになります。

foreign import data RANDOM :: Effect


詳しくはあとで見ていきますが、このように新たな作用を定義することが可能なのです。

Eff eff a型の式は、通常のJavaScriptのメソッドのようにJavaScriptから呼び出すことができます。例えば、この main関数は作用の集合 effと何らかの型 aについて Eff eff aという型でなければならないので、次のように実行することができます。

require('Main').main();


pulp build -O --toまたは pulp runを使用するときは、 mainモジュールが定義されていると、この mainの呼び出しを自動的に生成することができます。

10.15 新しい作用の定義

この章のソースコードでは、2つの新しい作用が定義されています。最も簡単なのは Control.Monad.Eff.Alertモジュールで定義された ALERT作用です。これはその計算がポップアップウィンドウを使用してユーザに警告しうることを示すために使われます。

この作用は最初に外部型宣言を使用して定義されています。

foreign import data ALERT :: Effect


Alertは種 Effectが与えられており、 Alertが型ではなく作用であることを示しています。

次に、 alertアクションが定義されています。 alertアクションはポップアップを表示し、作用の行に Alert作用を追加します。

foreign import alert :: forall eff. String -> Eff (alert :: ALERT | eff) Unit


JavaScriptモジュールは簡単で、 alert関数を exports変数に代入して定義します。

"use strict";

exports.alert = function(msg) {
    return function() {
        window.alert(msg);
    };
};



このアクションは Control.Monad.Eff.Consoleモジュールの logアクションととてもよく似ています。唯一の違いは、 logアクションが console.logメソッドを使用しているのに対し、 alertアクションは window.alertメソッドを使用していることです。このように、 alertは window.alertが定義されているウェブブラウザのような環境で使用することができます。

logの場合のように、 alert関数は型 Eff (alert :: ALERT | eff) Unitの計算を表現するために引数なしの関数を使っていることに注意してください。

この章で定義される２つめの作用は、 Control.Monad.Eff.Storageモジュールで定義されている STORAGE作用です。これは計算がWeb Storage APIを使用して値を読み書きする可能性があることを示すために使われます。

この作用も同じように定義されています。

foreign import data STORAGE :: Effect


Control.Monad.Eff.Storageモジュールには、ローカルストレージから値を取得する getItemと、ローカルストレージに値を挿入したり値を更新する setItemという、２つのアクションが定義されています。この二つの関数は、次のような型を持っています。

foreign import getItem :: forall eff . String
  -> Eff (storage :: STORAGE | eff) Foreign
foreign import setItem :: forall eff . String
  -> String -> Eff (storage :: STORAGE | eff) Unit


興味のある読者は、このモジュールのソースコードでこれらのアクションがどのように定義されているか調べてみてください。

setItemはキーと値(両方とも文字列)を受け取り、指定されたキーでローカルストレージに値を格納する計算を返します。

getItemの型はもっと興味深いものです。 getItemはキーを引数に取り、キーに関連付けられた値をローカルストレージから取得しようとします。 window.localStorageの getItemメソッドは nullを返すことがあるので、返り値は Stringではなく、 purescript-foreignパッケージの Data.Foreignモジュールで定義されている Foreignになっています。

Data.Foreignは、型付けされていないデータ、もっと一般的にいえば実行時表現が不明なデータを扱う方法を提供しています。

演習

	
(やや難しい) JavaScriptの Windowオブジェクトの confirmメソッドのラッパを書き、 Control.Monad.Eff.Alertモジュールにその関数を追加してください。



	
(やや難しい)localStorageオブジェクトの removeItemメソッドのラッパを書き、 Control.Monad.Eff.Storageモジュールに追加してください







10.16 型付けされていないデータの操作

この節では、型付けされていないデータを、その型の適切な実行時表現を持った型付けされたデータに変換する、 Data.Foreignライブラリの使い方について見て行きます。

この章のコードは、第8章の住所録の上にフォームの一番下に保存ボタンを追加することで作っていきます。保存ボタンがクリックされると、フォームの状態をJSONに直列化し、ローカルストレージに格納します。ページが再読み込みされると、JSON文書がローカルストレージから取得され、構文解析されます。

Mainモジュールではフォームデータの型を定義します。

newtype FormData = FormData
  { firstName  :: String
  , lastName   :: String
  , street     :: String
  , city       :: String
  , state      :: String
  , homePhone  :: String
  , cellPhone  :: String
  }


問題は、このJSONが正しい形式を持っているという保証がないことです。別の言い方をすれば、JSONが実行時にデータの正しい型を表しているかはわかりません。この問題は purescript-foreignライブラリによって解決することができます。他にも次のような使いかたがあります。


	WebサービスからJSONレスポンス

	JavaScriptコードから関数に渡された値



それでは、 PSCiで purescript-foreign及び purescript-foreign-genericライブラリを試してみましょう。

二つのモジュールをインポートして起動します。

> import Data.Foreign
> import Data.Foreign.Generic
> import Data.Foreign.JSON


Foreignな値を取得するためには、JSON文書を解析するのがいいでしょう。 purescript-foreignでは次の2つの関数が定義されています。

parseJSON :: String -> F Foreign
decodeJSON :: forall a. Decode a => String -> F a


型構築子Fは、実際にはData.Foreignで定義されている型同義語です。

type F = Except (NonEmptyList ForeignError)


ここでExceptは、Eitherのように、純粋なコードで例外を処理するためのモナドです。runExcept関数を使うと、Fモナドの値をEitherモナドの値に変換することができます。

この Decode型クラスは、それらの型が型付けされていないデータから得られることを表しています。プリミティブ型や配列については型クラスインスタンスがすでに定義されていますが、独自のインスタンスを定義することもできます。

それでは PSCiで readJSONを使用していくつかの簡単なJSON文書を解析してみましょう。

> import Control.Monad.Except

> runExcept (decodeJSON "\"Testing\"" :: F String)
Right "Testing"

> runExcept (decodeJSON "true" :: F Boolean)
Right true

> runExcept (decodeJSON "[1, 2, 3]" :: F (Array Int))
Right [1, 2, 3]


Eitherモナドでは Rightデータ構築子は成功を示していることを思い出してください。しかし、その不正なJSONや誤った型はエラーを引き起こすことに注意してください。

> runExcept (decodeJSON "[1, 2, true]" :: F (Array Int))
(Left (NonEmptyList (NonEmpty (ErrorAtIndex 2 (TypeMismatch "Int" "Boolean")) Nil)))


purescript-foreign-genericライブラリはJSON文書で型エラーが発生した位置を教えてくれます。

10.17 nullとundefined値の取り扱い

実世界のJSON文書にはnullやundefined値が含まれているので、それらも扱えるようにしなければなりません。

purescript-foreign-genericでは、この問題を解決する3種類の構築子、 Null、 Undefined、 NullOrUndefinedが定義されています。先に定義した Undefined型の構築子と似た目的を持っていますが、省略可能な値を表すために Maybe型の構築子を内部的に使っています。

それぞれの型の構築子について、ラップされた値から内側の値を取り出す関数、 runNullOrUndefinedが提供されています。 null値を許容するJSON文書を解析するには、 readJSONアクションまで対応する適切な関数を持ち上げます。

> import Prelude
> import Data.Foreign.NullOrUndefined

> runExcept (unNullOrUndefined 
  
  
  chapter11
  

  
chapter11
第11章 モナドの探求

11.1 この章の目標

この章の目標は、異なるモナドから提供された副作用を合成する方法を提供するモナド変換子(monad transformers)について学ぶことです。NodeJSのコンソール上で遊ぶことができる、テキストアドベンチャーゲームを題材として扱います。ゲームの様々な副作用(ロギング、状態、および設定)がすべてモナド変換子スタックによって提供されます。

11.2 プロジェクトの準備

このモジュールのプロジェクトでは以下のBower依存関係が新たに導入されます。


	purescript-maps　- 不変のマップと集合のためのデータ型を提供します。

	purescript-sets- 不変集合のデータ型を提供する標準的なモナド変換子の実装を提供する

	purescript-transformers- 標準のモナド変換子の実装を提供します。

	purescript-node-readline- NodeJSが提供するreadlineインターフェイスへのFFIバインディングを提供します。

	purescript-yargs- yargsコマンドライン引数処理ライブラリにApplicativeなインターフェイスを提供します。



また、NPMを使って yargsモジュールをインストールする必要があります。

npm install


11.3 ゲームの遊びかた

プロジェクトを実行するには、 pulp runでソースコードをビルドしてから、NodeJSにコンパイルされたJavaScriptを渡します。

デフォルトでは使い方が表示されます。

node ./dist/Main.js -p 

Options:
  -p, --player  Player name  [required]
  -d, --debug   Use debug mode

Missing required arguments: p
The player name is required


-pオプションを使ってプレイヤー名を指定してください。

pulp run -- -p Phil
> 


プロンプトからは、 look、 inventory、 take、 use、 north、 south、 east、 westなどのコマンドを入力することができます。 --debugコマンドラインオプションが与えられたときには、ゲームの状態を出力するための debugコマンドも使えます。

ゲームは2次元の碁盤の目の上でプレイし、コマンド north、 south、 east、 westを発行することによってプレイヤーが移動します。ゲームにはアイテムの配列があり、プレイヤーの所持アイテム一覧を表したり、ゲーム盤上のその位置にあるアイテムの一覧を表すのに使われます。 takeコマンドを使うと、プレイヤーの位置にあるアイテムを拾い上げることができます。

参考までに、このゲームのひと通りの流れは次のようになります。

$ pulp run -- -p Phil

> look
You are at (0, 0)
You are in a dark forest. You see a path to the north.
You can see the Matches.

> take Matches
You now have the Matches

> north
> look
You are at (0, 1)
You are in a clearing.
You can see the Candle.

> take Candle
You now have the Candle

> inventory
You have the Candle.
You have the Matches.

> use Matches
You light the candle.
Congratulations, Phil!
You win!


このゲームはとても単純ですが、この章の目的は purescript-transformersパッケージを使用してこのようなゲームを素早く開発できるようにするライブラリを構築することです。

11.4 Stateモナド

purescript-transformersパッケージで提供されるモナドをいくつか見てみましょう。

最初の例は、純粋な変更可能状態を提供する Stateモナドです。すでに Effモナド、すなわち REF作用と ST作用によって提供された変更可能な状態という2つのアプローチについては見てきました。 Stateは第3の選択肢を提供しますが、これは Effモナドを使用して実装されているわけではありません。

State型構築子は、状態の型 s、および返り値の型 aという2種類の引数を取ります。「 Stateモナド」というように説明はしていますが、実際には Monad型クラスのインスタンスが用意されているのは Stateに対してではなく、任意の型 sについての State s型構築子に対してです。

Control.Monad.Stateモジュールは以下のAPIを提供しています。

get    :: forall s.             State s s
put    :: forall s. s        -> State s Unit
modify :: forall s. (s -> s) -> State s Unit


これは REF作用や ST作用が提供するAPIととてもよく似ています。しかし、これらのアクションに Refや STRefに渡しているような、可変領域への参照を引数に渡さないことに注意してください。 Stateと Effモナドが提供する解決策の違いは、 Stateモナドは暗黙的な単一の状態だけを提供していることです。この状態は Stateモナドの型構築子によって隠された関数の引数として実装されており、参照は明示的には渡されないのです。

例を見てみましょう。 Stateモナドの使いかたのひとつとしては、状態を数として、現在の状態に配列の値を加算していくようなものかもしれません。状態の型 sとして Numberを選択し、配列の走査に traverse_を使って、配列の要素それぞれについて modifyを呼び出すと、これを実現することができます。

import Data.Foldable (traverse_)
import Control.Monad.State
import Control.Monad.State.Class

sumArray :: Array Number -> State Number Unit
sumArray = traverse_ \n -> modify \sum -> sum + n


Control.Monad.Stateモジュールは Stateモナドでの計算を実行するための次の3つの関数を提供します。

evalState :: forall s a. State s a -> s -> a
execState :: forall s a. State s a -> s -> s
runState  :: forall s a. State s a -> s -> Tuple a s


３つの関数はそれぞれ初期値の型 sと計算の型 State s aを引数にとります。 evalStateは返り値だけを返し、 execStateは最終的な状態だけを返し、 runStateは Tuple a s型の値として表現された返り値と状態の両方を返します。

先ほどの sumArray関数が与えられたとすると、 PSCiで次のように execStateを使うと複数の配列内の数字を合計することができます。

> :paste
… execState (do
…   sumArray [1, 2, 3]
…   sumArray [4, 5]
…   sumArray [6]) 0
… ^D
21


演習

	
(簡単) 上の例で、 execStateを runStateや evalStateで 置き換えると結果はどうなるでしょうか。



	
(やや難しい)Stateモナドと traverse_関数を使用して、次のような関数を書いてください。

testParens :: String -> Boolean


これは Stringが括弧の対応が正しく付けられているかどうかを調べる関数です。この関数は次のように動作しなくてはなりません。

> testParens ""
true

> testParens "(()(())())"
true

> testParens ")"
false

> testParens "(()()"
false


ヒント： 入力の文字列を文字の配列に変換するのに、 Data.Stringモジュールの split関数を使うと良いでしょう。







11.5 Readerモナド

purescript-transformersパッケージでは Readerというモナドも提供されています。このモナドは大域的な設定を読み取る機能を提供します。 Stateモナドがひとつの可変状態を読み書きする機能を提供するのに対し、 Readerモナドはデータの読み取りの機能だけを提供します。

Reader型構築子は、構成の型を表す型 r、および戻り値の型 aの2つの型引数を取ります。

Contro.Monad.Readerモジュールは以下のAPIを提供します。

ask   :: forall r. Reader r r
local :: forall r a. (r -> r) -> Reader r a -> Reader r a


askアクションは現在の設定を読み取るために使い、 localアクションは局所的に設定を変更して計算を実行するために使います。

たとえば、権限で制御されたアプリケーションを開発しており、現在の利用者の権限オブジェクトを保持するのに Readerモナドを使いたいとしましょう。型 rを次のようなAPIを備えた型 Permissionとして選択します。

hasPermission :: String -> Permissions -> Boolean
addPermission :: String -> Permissions -> Permissions


利用者が特定の権限を持っているかどうかを確認したいときは、 askを使って現在の権限オブジェクトを取得すればいつでも調べることができます。たとえば、管理者だけが新しい利用者の作成を許可されているとしましょう。

createUser :: Reader Permissions (Maybe User)
createUser = do
  permissions <- ask
  if hasPermission "admin" permissions
    then map Just newUser
    else pure Nothing


localアクションを使うと、計算の実行中に Permissionsオブジェクトを局所的に変更し、ユーザーの権限を昇格させることもできます。

runAsAdmin :: forall a. Reader Permissions a -> Reader Permissions a
runAsAdmin = local (addPermission "admin")


こうすると、利用者が admin権限を持っていなかった場合であっても、新しい利用者を作成する関数を書くことができます。

createUserAsAdmin :: Reader Permissions (Maybe User)
createUserAsAdmin = runAsAdmin createUser


Readerモナドの計算を実行するには、大域的な設定を与える runReader関数を使います。

runReader :: forall r a. Reader r a -> r -> a


演習
以下の演習では、 Readerモナドを使って、字下げのついた文書を出力するための小さなライブラリを作っていきます。「大域的な設定」は、現在の字下げの深さを示す数になります。



type Level = Number

type Doc = Reader Level String



	
(簡単)　現在の字下げの深さで文字列を出力する関数 lineを書いてください。その関数は、以下の型を持っている必要があります。

line :: String -> Doc


ヒント：現在の字下げの深さを読み取るためには ask関数を使用します。



	
(やや難しい)local関数を使用して、コードブロックの字下げの深さを大きくする次のような関数を書いてください。

indent :: Doc -> Doc




	
(やや難しい)Data.Traversableで定義された sequence関数を使用して、文書のリストを改行で区切って連結する次のような関数を書いてください。

cat :: Array Doc -> Doc




	
(やや難しい)runReader関数を使用して、文書を文字列として出力する次のような関数を書いてください。

render :: Doc -> String


これで、このライブラリを次のように使うと、簡単な文書を書くことができるはずです。

render $ cat
  [ line "Here is some indented text:"
  , indent $ cat
      [ line "I am indented"
      , line "So am I"
      , indent $ line "I am even more indented"
      ]
  ]






11.6 Writerモナド

Writerモナドは、計算の返り値に加えて、もうひとつの値を累積していく機能を提供します。

よくある使い方としては型 Stringもしくは Array Stringでログを累積していくというものなどがありますが、 Writerモナドはこれよりもっと一般的なものです。これは累積するのに任意のモノイドの値を使うことができ、 Sumモノイドを使って、合計を追跡し続けるのに使ったり、 Anyモノイドを使って途中の Boolean値がすべて真であるかどうかを追跡するのに使うことができます。

Writer型の構築子は、 Monoid型クラスのインスタンスである型 w、および返り値の型 aという2つの型引数を取ります。

WriterのAPIで重要なのは tell関数です。

tell :: forall w a. Monoid w => w -> Writer w Unit


tellアクションは、与えられた値を現在の累積結果に加算します。

例として、 Array Stringモノイドを使用して、既存の関数にログ機能を追加してみましょう。最大公約数関数の以前の実装を考えてみます。

gcd :: Int -> Int -> Int
gcd n 0 = n
gcd 0 m = m
gcd n m = if n > m
            then gcd (n - m) m
            else gcd n (m - n)


Writer (Array String) Intに返り値の型を変更することで、この関数にログ機能を追加することができます。

import Control.Monad.Writer
import Control.Monad.Writer.Class

gcdLog :: Int -> Int -> Writer (Array String) Int


各手順で二つの入力を記録するために、少し関数を変更する必要があります。

gcdLog n 0 = pure n
gcdLog 0 m = pure m
gcdLog n m = do
  tell ["gcdLog " <> show n <> " " <> show m]
  if n > m
    then gcdLog (n - m) m
    else gcdLog n (m - n)


Writerモナドの計算を実行するには、 execWriter関数と runWriter関数のいずれかを使います。

execWriter :: forall w a. Writer w a -> w
runWriter  :: forall w a. Writer w a -> Tuple a w


ちょうど Stateモナドの場合と同じように、 execWriterが累積されたログだけを返すのに対して、 runWriterは累積されたログと結果の両方を返します。

PSCiで修正された関数を試してみましょう。

> import Control.Monad.Writer
> import Control.Monad.Writer.Class

> runWriter (gcdLog 21 15)
Tuple 3 ["gcdLog 21 15","gcdLog 6 15","gcdLog 6 9","gcdLog 6 3","gcdLog 3 3"]


演習

	
(やや難しい)Writerモナドと purescript-monoidパッケージの Additive Intのモノイドを使うように、上の sumArray関数を書き換えてください。



	
(やや難しい)コラッツ関数は、自然数 nが偶数なら n / 2、 nが奇数なら 3 * n + 1であると定義されています。たとえば、 10で始まるコラッツ数列は次のようになります。

10, 5, 16, 8, 4, 2, 1, ...


コラッツ関数の有限回の適用を繰り返すと、コラッツ数列は必ず最終的に 1になるということとが予想できます。

数列が 1に到達するまでに何回のコラッツ関数の適用が必要かを計算する再帰的な関数を書いてください。

Writerモナドを使用してコラッツ関数のそれぞれの適用の経過を記録するように、関数を変更してください。







11.7 モナド変換子

上の3つのモナド、 State、 Reader、 Writerは、いずれもいわゆるモナド変換子(monad transformers)の例となっています。対応するモナド変換子はそれぞれ StateT、 ReaderT、 WriterTと呼ばれています。

モナド変換子とは何でしょうか。さて、これまで見てきたように、モナドはPureScriptで適切なハンドラ(runState、 runReader、 runWriterなど)を使って解釈される、いろいろな種類の副作用でPureScriptコードを拡張します。使用する必要がある副作用がひとつだけなら、これで問題ありません。しかし、同時に複数の副作用を使用できると便利なことがよくあります。例えば、 Maybeと Readerを一緒に使用すると、ある大域的な設定の文脈で省略可能な結果を表現することができます。もしくは、 Eitherモナドの純粋なエラー追跡機能と、 Stateモナドが提供する変更可能な状態が同時に欲しくなるかもしれません。この問題を解決するのがモナド変換子です。

拡張可能作用の手法を使うとネイティブな作用を混在させることができるので、 Effモナドはこの問題に対する部分的な解決策を提供していることをすでに見てきたことに注意してください。モナド変換子はまた異なった解決策を提供しますが、これらの手法にはそれぞれ利点と限界があります。

モナド変換子は型だけでなく別の型構築子によってもパラメータ化される型構築子です。モナド変換子はモナドをひとつ取り、独自のいろいろな副作用を追加した別のモナドへと変換します。

例を見てみましょう。 Control.Monad.State.Transで定義された StateTは Stateのモナド変換子版です。 PSCiを使って StateTの種を見てみましょう。

> import Control.Monad.State.Trans
> :kind StateT
Type -> (Type -> Type) -> Type -> Type


とても読みにくそうに思うかもしれませんが、使い方を理解するために、 StateTにひとつ引数を与えてみましょう。

Stateの場合、最初の型引数は使いたい状態の型です。それでは型 Stringを与えてみましょう。

> :kind StateT String
(Type -> Type) -> Type -> Type


次の引数は種 Type -> Typeの型構築子です。これは StateTの機能を追加したい元のモナドを表します。例として、 Either Stringモナドを選んでみます。

> :kind StateT String (Either String)
Type -> Type


型構築子が残りました。最後の引数は戻り値の型を表しており、たとえばそれを Numberにすることができます。

> :kind StateT String (Either String) Number
Type


最後に、種 Typeの何かが残りましたが、この型の値を探してみましょう。

構築したモナド StateT String (Either String)は、エラーで失敗する可能性があり、変更可能な状態を使える計算を表しています。

外側の StateT String (Either String)モナドのアクション(get、 put、 modify)は直接使うことができますが、ラップされている内側のモナド(Either String)の作用を使うためには、これらの関数をモナド変換子まで「持ち上げ」なくてはいけません。 Control.MonadTransモジュールでは、モナド変換子であるような型構築子を捕捉する MonadTrans型クラスを次のように定義しています。

class MonadTrans t where
  lift :: forall m a. Monad m => m a -> t m a


このクラスは、基礎となる任意のモナド mの計算をとり、それをラップされたモナド t mへと持ち上げる、 liftというひとつの関数だけを持っています。今回の場合、型構築子 tは StateT Stringで、 mは Either Stringモナドとなり、 liftは型 Either String aの計算を、型 State String (Either String) aの計算へと持ち上げる方法を提供することになります。これは、型 Either String aの計算を使うときは、 liftを使えばいつでも作用 StateT Stringと Either Stringを隣り合わせに使うことができることを意味します。

たとえば、次の計算は StateTモナド変換子で導入されている状態を読み込み、状態が空の文字列である場合はエラーを投げます。

import Data.String (drop, take)

split :: StateT String (Either String) String
split = do
  s <- get
  case s of
    "" -> lift $ Left "Empty string"
    _ -> do
      put (drop 1 s)
      pure (take 1 s)


状態が空でなければ、この計算は putを使って状態を drop 1 s(最初の文字を取り除いた s)へと更新し、 take 1 s(sの最初の文字)を返します。

それでは PSCiでこれを試してみましょう。

> runStateT split "test"
Right (Tuple "t" "est")

> runStateT split ""
Left "Empty string"


これは StateTを使わなくても実装できるので、さほど驚くようなことではありません。しかし、モナドとして扱っているので、do記法やApplicativeコンビネータを使って、小さな計算から大きな計算を構築していくことができます。例えば、2回 splitを適用すると、文字列から最初の2文字を読むことができます。

> runStateT ((<>) 
  
  
  chapter12
  

  
chapter12
第12章 コールバック地獄

12.1 この章の目標

この章では、これまでに見てきたモナド変換子やApplicative関手といった道具が、現実世界の問題解決にどのように役立つかを見ていきましょう。ここでは特に、コールバック地獄(callback hell)の問題を解決について見ていきます。

12.2 プロジェクトの準備

この章のソースコードは、 pulp runを使ってコンパイルして実行することができます。 また、 requestモジュールをNPMを使ってインストールする必要があります。

npm install


12.3 問題

通常、JavaScriptの非同期処理コードでは、プログラムの流れを構造化するためにコールバック(callbacks)を使用します。たとえば、ファイルからテキストを読み取るのに好ましいアプローチとしては、 readFile関数を使用し、コールバック、つまりテキストが利用可能になったときに呼び出される関数を渡すことです。

function readText(onSuccess, onFailure) {
  var fs = require('fs');
  fs.readFile('file1.txt', { encoding: 'utf-8' }, function (error, data) {
    if (error) {
      onFailure(error.code);
    } else {
      onSuccess(data);
    }   
  });
}


しかしながら、複数の非同期操作が関与している場合には入れ子になったコールバックを生じることになり、すぐに読めないコードになってしまいます。

function copyFile(onSuccess, onFailure) {
  var fs = require('fs');
  fs.readFile('file1.txt', { encoding: 'utf-8' }, function (error, data1) {
    if (error) {
      onFailure(error.code);
    } else {
      fs.writeFile('file2.txt', data, { encoding: 'utf-8' }, function (error) {
        if (error) {
          onFailure(error.code);
        } else {
          onSuccess();
        }
      });
    }   
  });
} 


この問題に対する解決策のひとつとしては、独自の関数に個々の非同期呼び出しを分割することです。

function writeCopy(data, onSuccess, onFailure) {
  var fs = require('fs');
  fs.writeFile('file2.txt', data, { encoding: 'utf-8' }, function (error) {
    if (error) {
      onFailure(error.code);
    } else {
      onSuccess();
    }
  });
}

function copyFile(onSuccess, onFailure) {
  var fs = require('fs');
  fs.readFile('file1.txt', { encoding: 'utf-8' }, function (error, data) {
    if (error) {
      onFailure(error.code);
    } else {
      writeCopy(data, onSuccess, onFailure);
    }   
  });
} 


この解決策は一応は機能しますが、いくつか問題があります。


	上で writeCopyへ dataを渡したのと同じ方法で、非同期関数に関数の引数として途中の結果を渡さなければなりません。これは小さな関数についてはうまくいきますが、多くのコールバック関係する場合はデータの依存関係は複雑になることがあり、関数の引数が大量に追加される結果になります。

	どんな非同期関数でもコールバック onSuccessと onFailureが引数として定義されるという共通のパターンがありますが、このパターンはソースコードに付随したモジュールのドキュメントに記述することで実施しなければなりません。このパターンを管理するには型システムのほうがよいですし、型システムで使い方を強制しておくほうがいいでしょう。



次に、これらの問題を解決するために、これまでに学んだ手法を使用する方法について説明していきます。

12.4 継続モナド

copyFileの例をFFIを使ってPureScriptへと翻訳していきましょう。PureScriptで書いていくにつれ、計算の構造はわかりやすくなり、 purescript-transformersパッケージで定義されている継続モナド変換子 ContTが自然に導入されることになるでしょう。

まず、FFIを使って readFileと writeFileに型を与えなくてはなりません。型同義語をいくつかと、ファイル入出力のための作用を定義することから始めましょう。

foreign import data FS :: Effect

type ErrorCode = String
type FilePath = String


readFileはファイル名と2引数のコールバックを引数に取ります。ファイルが正常に読み込まれた場合は、2番目の引数にはファイルの内容が含まれますが、そうでない場合は、最初の引数がエラーを示すために使われます。

今回は readFileを2つのコールバックを引数としてとる関数としてラップすることにします。先ほどの copyFileや writeCopyとまったく同じように、エラーコールバック(onFailure)と結果コールバック(onSuccess)の2つです。簡単のために Data.Functionの多引数関数の機能を使うと、このラップされた関数 readFileImplは次のようになるでしょう。

foreign import readFileImpl
  :: forall eff
   . Fn3 FilePath
         (String -> Eff (fs :: FS | eff) Unit)
         (ErrorCode -> Eff (fs :: FS | eff) Unit)
         (Eff (fs :: FS | eff) Unit)


外部JavaScriptモジュールでは、readFileImplは次のように定義されます。

exports.readFileImpl = function(path, onSuccess, onFailure) {
  return function() {
    require('fs').readFile(path, {
      encoding: 'utf-8'
    }, function(error, data) {
      if (error) {
        onFailure(error.code)();
      } else {
        onSuccess(data)();
      }
    });
  };
};


readFileImplはファイルパス、成功時のコールバック、失敗時のコールバックという３つの引数を取り、空(Unit)の結果を返す副作用のある計算を返す、ということをこの型は言っています。コー​​ルバック自身にも、その作用を追跡するために Effモナドを使うような型が与えられていることに注意してください。

この readFileImplの実装がその型の正しい実行時表現を持っている理由を、よく理解しておくようにしてください。

writeFileImplもよく似ています。違いはファイルがコールバックではなく関数自身に渡されるということだけです。実装は次のようになります。

foreign import writeFileImpl
  :: forall eff
   . Fn4 FilePath
         String
         (Eff (fs :: FS | eff) Unit)
         (ErrorCode -> Eff (fs :: FS | eff) Unit)
         (Eff (fs :: FS | eff) Unit)


exports.writeFileImpl = function(path, data, onSuccess, onFailure) {
  return function() {
    require('fs').writeFile(path, data, {
      encoding: 'utf-8'
    }, function(error) {
      if (error) {
        onFailure(error.code)();
      } else {
        onSuccess();
      }
    });
  };
};


これらのFFIの宣言が与えられれば、 readFileと writeFileの実装を書くことができます。 Data.Functionライブラリを使って、多引数のFFIバインディングを通常の(カリー化された)PureScript関数へと変換するので、もう少し読みやすい型になるでしょう。

さらに、成功時と失敗時の２つの必須のコールバックに代わって、成功か失敗のどちらか(Either) に対応した単一のコールバックを要求するようにします。つまり、新しいコールバックは引数として Either ErrorCodeモナドの値をとります。

readFile :: forall eff . FilePath
  -> (Either ErrorCode String -> Eff (fs :: FS | eff) Unit)
  -> Eff (fs :: FS | eff) Unit
readFile path k =
  runFn3 readFileImpl
         path
         (k <<< Right)
         (k <<< Left)

writeFile :: forall eff . FilePath
  -> String
  -> (Either ErrorCode Unit -> Eff (fs :: FS | eff) Unit)
  -> Eff (fs :: FS | eff) Unit
writeFile path text k =
  runFn4 writeFileImpl
         path
         text
         (k $ Right unit)
         (k <<< Left)


ここで、重要なパターンを見つけることができます。これらの関数は何らかのモナド(この場合は Eff (fs :: FS | eff))で値を返すコールバックをとり、同一のモナドで値を返します。これは、最初のコールバックが結果を返したときに、そのモナドは次の非同期関数の入力に結合するためにその結果を使用することができることを意味しています。実際、 copyFileの例で手作業でやったことがまさにそれです。

これは purescript-transformersの Control.Monad.Cont.Transモジュールで定義されている継続モナド変換子(continuation monad transformer)の基礎となっています。

ContTは次のようなnewtypeとして定義されます。

newtype ContT r m a = ContT ((a -> m r) -> m r)


継続(continuation)はコールバックの別名です。継続は計算の残余(remainder)を捕捉します。ここで「残余」とは、非同期呼び出しが行われ、結果が提供された後に起こることを指しています。

ContTデータ構築子の引数は readFileと writeFileの型ととてもよく似ています。実際、もし型aをErrorCode String型、rをUnit、mをモナドEff(fs :: FS | eff)というように選ぶと、readFileの型の右辺を復元することができます。

readFileやwriteFileのような非同期のアクションを組み立てるために使うAsyncモナドを定義するため、次のような型同義語を導入します。

type Async eff = ContT Unit (Eff eff)


今回の目的では Effモナドを変換するために常に ContTを使い、型 rは常に Unitになりますが、必ずそうしなければならないというわけではありません。

ContTデータ構築子を適用するだけで、 readFileと writeFileを Asyncモナドの計算として扱うことができます。

readFileCont
  :: forall eff
   . FilePath
  -> Async (fs :: FS | eff) (Either ErrorCode String)
readFileCont path = ContT $ readFile path

writeFileCont
  :: forall eff
   . FilePath
  -> String
  -> Async (fs :: FS | eff) (Either ErrorCode Unit)
writeFileCont path text = ContT $ writeFile path text


ここで ContTモナド変換子に対してdo記法を使うだけで、ファイル複製処理を書くことができます。

copyFileCont
  :: forall eff
   . FilePath
  -> FilePath
  -> Async (fs :: FS | eff) (Either ErrorCode Unit)
copyFileCont src dest = do
  e <- readFileCont src
  case e of
    Left err -> pure $ Left err
    Right content -> writeFileCont dest content


readFileContの非同期性がdo記法によってモナドの束縛に隠されていることに注目してください。これはまさに同期的なコードのように見えますが、 ContTモナド変換子は非同期関数を書くのを手助けしているのです。

継続を与えて runContTハンドラを使うと、この計算を実行することができます。この継続は次に何をするか、例えば非同期なファイル複製処理が完了した時に何をするか、を表しています。この簡単な例では、型 Either ErrorCode Unitの結果をコンソールに出力する logShow関数を単に継続として選んでいます。

import Prelude

import Control.Monad.Eff.Console (logShow)
import Control.Monad.Cont.Trans (runContT)

main =
  runContT
    (copyFileCont "/tmp/1.txt" "/tmp/2.txt")
    logShow


演習

	
(簡単)readFileContと writeFileContを使って、2つのテキストフ​​ァイルを連結する関数を書いてください。



	
(やや難しい) FFIを使って、 setTimeout関数に適切な型を与えてください。また、 Asyncモナドを使った次のようなラッパー関数を書いてください。

type Milliseconds = Int

foreign import data TIMEOUT :: Effect

setTimeoutCont
  :: forall eff
   . Milliseconds
  -> Async (timeout :: TIMEOUT | eff) Unit








12.5 ExceptTを機能させる

この方法はうまく動きますが、まだ改良の余地があります。

copyFileContの実装において、次に何をするかを決定するためには、パターン照合を使って(型 Either ErrorCode Stringの)readFileCont計算の結果を解析しなければなりません。しかしながら、 Eitherモナドは対応するモナド変換子 ExceptTを持っていることがわかっているので、 ContTを持つ ExceptTを使って非同期計算とエラー処理の２つの作用を結合できると期待するのは理にかなっています。

実際にそれは可能で、 ExceptTの定義を見ればそれがなぜかがわかります。

newtype ExceptT e m a = ExceptT (m (Either e a))


ExceptTは基礎のモナドの結果を単純に aから Either e aに変更します。現在のモナドスタックを ExceptT ErrorCode変換子で変換するように、 copyFileContを書き換えることができることを意味します。それは現在の方法に ExceptTデータ構築子を適用するだけなので簡単です。型同義語を与えると、ここでも型シグネチャを整理することができます。

readFileContEx
  :: forall eff
   . FilePath
  -> ExceptT ErrorCode (Async (fs :: FS | eff)) String
readFileContEx path = ExceptT $ readFileCont path

writeFileContEx
  :: forall eff
   . FilePath
  -> String
  -> ExceptT ErrorCode (Async (fs :: FS | eff)) Unit
writeFileContEx path text = ExceptT $ writeFileCont path text


非同期エラー処理が ExceptTモナド変換子の内部に隠されているので、このファイル複製処理ははるかに単純になります。

copyFileContEx
  :: forall eff
   . FilePath
  -> FilePath
  -> ExceptT ErrorCode (Async (fs :: FS | eff)) Unit
copyFileContEx src dest = do
  content <- readFileContEx src
  writeFileContEx dest content


演習

	
(やや難しい) 任意のエラーを処理するために、 ExceptTを使用して2つのファイルを連結しする先ほどの解決策を書きなおしてください。



	
(やや難しい) 入力ファイル名の配列を与えて複数のテキストファイルを連結する関数 concatenateManyを書く。 ヒント：traverseを使用します。







12.6 HTTPクライアント

ContTを使って非同期機能を処理する例として、この章のソースコードの Network.HTTP.Clientモジュールについても見ていきましょう。このモジュールでは Asyncモナドを使用して、NodeJSの非同期を requestモジュールを使っています。

requestモジュールは、URLとコールバックを受け取り、応答が利用可能なとき、またはエラーが発生したときにHTTP（S）リクエストを生成してコールバックを呼び出す関数を提供します。 リクエストの例を次に示します。

require('request')('http://purescript.org'), function(err, _, body) {
  if (err) {
    console.error(err);
  } else {
    console.log(body);
  }
});


Asyncモナドを使うと、この簡単な例をPureScriptで書きなおすことができます。

Network.HTTP.Clientモジュールでは、 requestメソッドは以下のようなAPIを持つ関数 getImplとしてラップされています。

foreign import data HTTP :: Effect

type URI = String

foreign import getImpl
  :: forall eff
   . Fn3 URI
         (String -> Eff (http :: HTTP | eff) Unit)
         (String -> Eff (http :: HTTP | eff) Unit)
         (Eff (http :: HTTP | eff) Unit)


exports.getImpl = function(uri, done, fail) {
  return function() {
    require('request')(uri, function(err, _, body) {
      if (err) {
        fail(err)();
      } else {
        done(body)();
      }
    });
  };
};


再びData.Function.Uncurriedモジュールを使って、これを通常のカリー化されたPureScript関数に変換します。先ほどと同じように、２つのコールバックをMaybe Chunk型の値を受け入れるひとつのコールバックに変換しています。Either String String型の値を受け取り、ContTデータ構築子を適用してAsyncモナドのアクションを構築します。

get :: forall eff.
  URI ->
  Async (http :: HTTP | eff) (Either String String)
get req = ContT \k ->
  runFn3 getImpl req (k <<< Right) (k <<< Left)


演習

	
(やや難しい)runContTを使ってHTTP応答の各チャンクをコンソールへ出力することで、 getを試してみてください。



	
(やや難しい)readFileContと writeFileContに対して以前に行ったように、 ExceptTを使い getをラップする関数 getExを書いてください。







1.（難しい） getExと writeFileContExを使って、ディスク上のファイルからの内容をを保存する関数を書いてください。

12.7 並列計算

ContTモナドとdo記法を使って、非同期計算を順番に実行されるように合成する方法を見てきました。非同期計算を並列に合成することもできたら便利でしょう。

もしContTを使ってEffモナドを変換しているなら、単に２つの計算のうち一方を開始した後に他方の計算を開始すれば、並列に計算することができます。

purescript-parallelパッケージは型クラスParallelを定義します。この型クラスはモナドのために並列計算を提供するAsyncのようなものです。以前に本書でApplicative関手を導入したとき、並列計算を合成するときにApplicative関手がどのように便利なのかを観察しました。実はParallelのインスタンスは、(Asyncのような)モナドmと、並列に計算を合成するために使われるApplicative関手fとの対応関係を定義しているのです。

class (Monad m, Applicative f) <= Parallel f m | m -> f, f -> m where
  sequential :: forall a. f a -> m a
  parallel :: forall a. m a -> f a


このクラスは2つの関数を定義しています。


	parallel：モナド mを計算し、それを応用ファンクタ fの計算に変換します。

	sequential：反対方向の変換を行います。



purescript-parallelライブラリは Asyncモナドの Parallelインスタンスを提供します。 これは、2つの継続(continuation)のどちらが呼び出されたかを追跡することによって、変更可能な参照を使用して並列に Asyncアクションを組み合わせます。 両方の結果が返されたら、最終結果を計算してメインの継続に渡すことができます。

parallel関数を使うとreadFileContアクションの別のバージョンを作成することもできます。これは並列に組み合わせることができます。２つのテキストファイルを並列に読み取り、連結してその結果を出力する簡単な例は次のようになります。

import Prelude
import Control.Apply (lift2)
import Control.Monad.Cont.Trans (runContT)
import Control.Monad.Eff.Console (logShow)
import Control.Monad.Parallel (parallel, sequential)

main = flip runContT logShow do
  sequential $
   lift2 append
     <$> parallel (readFileCont "/tmp/1.txt")
     <*> parallel (readFileCont "/tmp/2.txt")


readFileContは Either ErrorCode String型の値を返すので、 lift2を使って Either型構築子より append関数を持ち上げて結合関数を形成する必要があることに注意してください。

Applicative関手では任意個引数の関数の持ち上げができるので、このApplicativeコンビネータを使ってより多くの計算を並列に実行することができます。 traverseと sequenceのようなApplicative関手を扱うすべての標準ライブラリ関数から恩恵を受けることもできます。

必要に応じて Parralelと runParallelを使って型構築子を変更することで、do記法ブロックのApplicativeコンビネータを使って、直列的なコードの一部で並列計算を結合したり、またはその逆を行ったりすることができます。

演習

	
(簡単)parallelと sequentialを使って2つのHTTPリクエストを作成し、それらのレスポンス内容を並行して収集します。あなたの結合関数は2つのレスポンス内容を連結しなければならず、続けて printを使って結果をコンソールに出力してください。



	
(やや難しい)Asyncに対応するapplicative関手は Alternativeのインスタンスです。このインスタンスによって定義される 
  
  
  chapter13
  

  
chapter13
第13章 テストの自動生成

13.1 この章の目標

この章では、テスティングの問題に対する、型クラスの特に洗練された応用について示します。どのようにテストするのかをコンパイラに教えるのではなく、コードがどのような性質を持っているべきかを教えることでテストします。型クラスを使って無作為データ生成のための定型コードを隠し、テストケースを仕様から無作為に生成することができます。これは生成的テスティング(generative testing、またはproperty-based testing）と呼ばれ、HaskellのQuickCheckライブラリによって知られるようになった手法です。

purescript-quickcheckパッケージはHaskellのQuickCheckライブラリをPureScriptにポーティングしたもので、型や構文はもとのライブラリとほとんど同じようになっています。 purescript-quickcheckを使って簡単なライブラリをテストし、Pulpでテストスイートを自動化されたビルドに統合する方法を見ていきます。

13.2 プロジェクトの準備

この章のプロジェクトにはBower依存関係として purescript-quickcheckが追加されます。

Pulpプロジェクトでは、テストソースは testディレクトリに置かれ、テストスイートのメインモジュールは Test.Mainと名づけられます。 テストスイートは、 pulp testコマンドを使用して実行できます。

13.3 プロパティの書き込み

Mergeモジュールでは purescript-quickcheckライブラリの機能を実演するために使う簡単な関数 mergeが実装されています。

merge :: Array Int -> Array Int -> Array Int


mergeは2つのソートされた数の配列をとって、その要素を統合し、ソートされた結果を返します。例えば次のようになります。

> import Merge
> merge [1, 3, 5] [2, 4, 6]

[1, 2, 3, 4, 5, 6]


典型的なテストスイートでは、手作業でこのような小さなテストケースをいくつも作成し、結果が正しい値と等しいことを確認することでテスト実施します。しかし、 merge関数について知る必要があるものはすべて、2つの性質に要約することができます。


	(既ソート性)xsと ysがソート済みなら、 merge xs ysもソート済みになります。

	（部分配列） xsと ysははどちらも merge xs ysの部分配列で、要素は元の配列と同じ順序で現れます。



purescript-quickcheckでは、無作為なテストケースを生成することで、直接これらの性質をテストすることができます。コードが持つべき性質を、次のような関数として述べるだけです。

main = do
  quickCheck \xs ys ->
    isSorted $ merge (sort xs) (sort ys)
  quickCheck \xs ys ->
    xs `isSubarrayOf` merge xs ys


ここで、 isSortedと isSubarrayOfは次のような型を持つ補助関数として実装されています。

isSorted :: forall a. Ord a => Array a -> Boolean
isSubarrayOf :: forall a. Eq a => Array a -> Array a -> Boolean


このコードを実行すると、 purescript-quickcheckは無作為な入力 xsと ysを生成してこの関数に渡すことで、主張しようとしている性質を反証しようとします。何らかの入力に対して関数が falseを返した場合、性質は正しくないことが示され、ライブラリはエラーを発生させます。幸いなことに、次のように100個の無作為なテストケースを生成しても、ライブラリはこの性質を反証することができません。

$ pulp test

* Build successful. Running tests...

100/100 test(s) passed.
100/100 test(s) passed.

* Tests OK.


もし merge関数に意図的にバグを混入した場合（例えば、大なりのチェックを小なりのチェックへと変更するなど）、最初に失敗したテストケースの後で例外が実行時に投げられます。

Error: Test 1 failed:
Test returned false


このエラーメッセージではあまり役に立ちませんが、これから見ていくように、少しの作業で改良することができます。

13.4 エラーメッセージの改善

テストケースが失敗した時に同時にエラーメッセージを提供するには、 purescript-quickcheckの 
  
  
  chapter14
  

  
chapter14
第14章 領域特化言語

14.1 この章の目標

この章では、多数の標準的な手法を使ったPureScriptにおける領域特化言語(domain-specific language, DSL) の実装について探求していきます。

領域特化言語とは、特定の問題領域での開発に適した言語のことです。領域特化言語の構文および機能は、その領域内の考え方を表現するコードの読みやすさを最大限に発揮すべく選択されます。本書の中では、すでに領域特化言語の例を幾つか見てきています。


	第11章で開発された Gameモナドと関連するアクションは、テキストアドベンチャーゲーム開発という領域に対しての領域特化言語を構成しています。

	第12章で ContTと Parallel関手のために書いたコンビネータのライブラリは、非同期プログラミングの領域に対する領域特化言語の例と考えることができます。

	第13章で扱った purescript-quickcheckパッケージは、生成的テスティングの領域の領域特化言語です。このコンビネータはテストの性質対して特に表現力の高い記法を可能にします。



この章では、領域特化言語の実装において、いくつかの標準的な手法による構造的なアプローチを取ります。これがこの話題の完全な説明だということでは決してありませんが、独自の目的に対する具体的なDSLを構築するには十分な知識を与えてくれるでしょう。

この章で実行している例は、HTML文書を作成するための領域特化言語になります。正しいHTML文書を記述するための型安全な言語を開発することが目的で、少しづつ実装を改善することによって作業していきます。

14.2 プロジェクトの準備

この章で使うプロジェクトには新しいBower依存性が追加されます。これから使う道具のひとつであるFreeモナドが定義されている purescript-freeライブラリです。

このプロジェクトのソースコードは、PSCiを使ってビルドすることができます。

14.3 HTMLデータ型

このHTMLライブラリの最も基本的なバージョンは Data.DOM.Simpleモジュールで定義されています。このモジュールには次の型定義が含まれています。

newtype Element = Element
  { name         :: String
  , attribs      :: Array Attribute
  , content      :: Maybe (Array Content)
  }

data Content
  = TextContent String
  | ElementContent Element

newtype Attribute = Attribute
  { key          :: String
  , value        :: String
  }


Element型はHTMLの要素を表しており、各要素は要素名、属性のペア​​の配列と、要素の内容でで構成されています。 contentプロパティでは、 Maybeタイプを使って要素が開いている(他の要素やテキストを含む)か閉じているかを示しています。

このライブラリの鍵となる機能は次の関数です。

render :: Element -> String


この関数はHTML要素をHTML文字列として出力します。 PSCiで明示的に適当な型の値を構築し、ライブラリのこのバージョンを試してみましょう。

$ pulp repl

> import Prelude
> import Data.DOM.Simple
> import Data.Maybe
> import Control.Monad.Eff.Console

> :paste
… log $ render $ Element
…   { name: "p"
…   , attribs: [
…       Attribute
…         { key: "class"
…         , value: "main"
…         }
…     ]
…   , content: Just [
…       TextContent "Hello World!"
…     ]
…   }
… ^D

Hello World!

unit


現状のライブラリにはいくつかの問題があります。


	HTML文書の作成に手がかかります。すべての新しい要素が少なくとも1つのレコードと1つのデータ構築子が必要です。

	無効な文書を表現できてしまいます。

	要素名の入力を間違えるかもしれません

	要素に間違った型の属性を関連付けることができてしまいます

	開いた要素が正しい場合でも、閉じた要素を使用することができてしまいます







この章では、さまざまな手法を用いてこれらの問題を解決し、このライブラリーをHTML文書を作成するために使える領域特化言語にしていきます。

14.4 スマート構築子

最初に導入する手法は方法は単純なものですが、とても効果的です。モジュールの使用者にデータの表現を露出する代わりに、モジュールエクスポートリスト(module exports list)を使ってデータ構築子 Element、 Content、 Attributeを隠蔽し、正しいことが明らかなデータだけ構築する、いわゆるスマート構築子(smart constructors)だけをエクスポートします。

例を示しましょう。まず、HTML要素を作成するための便利な関数を提供します。

element :: String -> Array Attribute -> Maybe (Array Content) -> Element
element name attribs content = Element
  { name:      name
  , attribs:   attribs
  , content:   content
  }


次に、 element関数を適用することによってHTML要素を作成する、スマート構築子を作成します。

a :: Array Attribute -> Array Content -> Element
a attribs content = element "a" attribs (Just content)

p :: Array Attribute -> Array Content -> Element
p attribs content = element "p" attribs (Just content)

img :: Array Attribute -> Element
img attribs = element "img" attribs Nothing


最後に、正しいデータ構造だけを構築することがわかっているこれらの関数をエクスポートするように、モジュールエクスポートリストを更新します。

module Data.DOM.Smart
  ( Element
  , Attribute(..)
  , Content(..)

  , a
  , p
  , img

  , render
  ) where


モジュールエクスポートリストはモジュール名の直後の括弧内に書きます。各モジュールのエクスポートは次の3種類のいずれかです。


	値の名前で示された、値(または関数)

	クラスの名で示された、型クラス

	型の名前で示された型構築子、およびそれに続けて括弧で囲まれた関連するデータ構築子のリスト



ここでは、 Elementの型をエクスポートしていますが、データ構築子はエクスポートしていません。もしデータ構築子をエクスポートすると、モジュールの使用者が不正なHTML要素を構築できてしまいます。

Attributeと Content型についてはデータ構築子をすべてエクスポートしています(エクスポートリストの記号 ..で示されています)。これから、これらの型にスマート構築子の手法を適用していきます。

すでにライブラリにいくつかの大きな改良を加わっていることに注意してください。


	不正な名前を持つHTML要素を表現することは不可能です(もちろん、ライブラリが提供する要素名に制限されています)。

	閉じた要素は、構築するときに内容を含めることはできません。



Content型にもとても簡単にこの手法を適用することができます。単にエクスポートリストから Content型のデータ構築子を取り除き、次のスマート構築子を提供します。

text :: String -> Content
text = TextContent

elem :: Element -> Content
elem = ElementContent


Attribute型にも同じ手法を適用してみましょう。まず、属性のための汎用のスマート構築子を用意します。最初の試みとしては、次のようなものになるかもしれません。

attribute :: String -> String -> Attribute
attribute key value = Attribute
  { key: key
  , value: value
  }

infix 4 attribute as :=


この定義では元の Element型と同じ問題に悩まされています。存在しなかったり、名前が間違っているような属性を表現することが可能です。この問題を解決するために、属性名を表すnewtypeを作成します。

newtype AttributeKey = AttributeKey String


それから、この演算子を次のように変更します。

attribute :: AttributeKey -> String -> Attribute
attribute (AttributeKey key) value = Attribute
  { key: key
  , value: value
  }


AttributeKeyデータ構築子をエクスポートしなければ、明示的にエクスポートされた次のような関数を使う以外に、使用者が型 AttributeKeyの値を構築する方法はありません。いくつかの例を示します。

href :: AttributeKey
href = AttributeKey "href"

_class :: AttributeKey
_class = AttributeKey "class"

src :: AttributeKey
src = AttributeKey "src"

width :: AttributeKey
width = AttributeKey "width"

height :: AttributeKey
height = AttributeKey "height"


新しいモジュールの最終的なエクスポートリストは次のようになります。もうどんなデータ構築子も直接エクスポートしていないことに注意してください。

module Data.DOM.Smart
  ( Element
  , Attribute
  , Content
  , AttributeKey

  , a
  , p
  , img

  , href
  , _class
  , src
  , width
  , height

  , attribute, (:=)
  , text
  , elem

  , render
  ) where


PSCiでこの新しいモジュールを試してみると、コードが大幅に簡潔になり、改良されていることがわかります。

$ pulp repl

> import Prelude
> import Data.DOM.Smart
> import Control.Monad.Eff.Console
> log $ render $ p [ _class := "main" ] [ text "Hello World!" ]

Hello World!

unit


しかし、基礎のデータ表現が変更されていないので、 render関数を変更する必要はなかったことにも注目してください。これはスマート構築子による手法の利点のひとつです。外部APIの使用者によって認識される表現から、モジュールの内部データ表現を分離することができるのです。

演習

	
(簡単)Data.DOM.Smartモジュールで renderを使った新しいHTML文書の作成を試してみましょう。



	
(やや難しい)　checkedと disabledなど、値を要求しないHTML属性がありますが、これらは次のような空の属性として表示されるかもしれません。

&lt;input disabled&gt;


空の属性を扱えるように Attributeの表現を変更してください。要素に空の属性を追加するために、 attributeまたは :=の代わりに使える関数を記述してください。







14.5 幻影型

次に適用する手法についての動機を与えるために、次のコードを考えてみます。

> log $ render $ img
    [ src    := "cat.jpg"
    , width  := "foo"
    , height := "bar"
    ]

<img src="cat.jpg" width="foo" height="bar" />
unit


ここでの問題は、 widthと heightについての文字列値を提供しているということで、ここで与えることができるのはピクセルやパーセントの単位の数値だけであるべきです。

AttributeKey型にいわゆる幻影型(phantom type)引数を導入すると、この問題を解決できます。

newtype AttributeKey a = AttributeKey String


定義の右辺に対応する型 aの値が存在しないので、この型変数 aは幻影型と呼ばれています。この型 aはコンパイル時により多くの情報を提供するためだけに存在しています。任意の型 AttributeKey aの値は実行時には単なる文字列ですが、そのキーに関連付けられた値に期待されている型を教えてくれます。

AttributeKeyの新しい形式で受け取るように、 attribute関数の型を次のように変更します。

attribute :: forall a. IsValue a => AttributeKey a -> a -> Attribute
attribute (AttributeKey key) value = Attribute
  { key: key
  , value: toValue value
  }


ここで、幻影型の引数 aは、属性キーと属性値が互換性のある型を持っていることを確認するために使われます。使用者は AttributeKey aを型の値を直接作成できないので(ライブラリで提供されている定数を介してのみ得ることができます)、すべての属性が正しくなります。

IsValue制約は、キーに関連付けられた値がなんであれ、その値を文字列に変換し、生成したHTML内に出力できることを保証します。 IsValue型クラスは次のように定義されています。

class IsValue a where
  toValue :: a -> String


Stringと Int型についての型クラスインスタンスも提供しておきます。

instance stringIsValue :: IsValue String where
  toValue = id

instance intIsValue :: IsValue Int where
  toValue = show


また、これらの型が新しい型変数を反映するように、 AttributeKey定数を更新しなければいけません。

href :: AttributeKey String
href = AttributeKey "href"

_class :: AttributeKey String
_class = AttributeKey "class"

src :: AttributeKey String
src = AttributeKey "src"

width :: AttributeKey Int
width = AttributeKey "width"

height :: AttributeKey Int
height = AttributeKey "height"


これで、不正なHTML文書を表現することが不可能で、 widthと height属性を表現するのに数を使うことが強制されていることがわかります。

> import Prelude
> import Data.DOM.Phantom
> import Control.Monad.Eff.Console

> :paste
… log $ render $ img
…   [ src    := "cat.jpg"
…   , width  := 100
…   , height := 200
…   ]
… ^D

<img src="cat.jpg" width="100" height="200" />
unit


演習

	
(簡単) ピクセルまたはパーセントの長さのいずれかを表すデータ型を作成してください。その型について IsValueのインスタンスを書いてください。この型を使うように widthと height属性を変更してください。



	
(難しい) 幻影型を使って真偽値 true、 falseについての表現を最上位で定義することで、 AttributeKeyが disabledや chackedのような空の属性を表現しているかどうかを符号化することができます。

data True
data False


幻影型を使って、使用者が attribute演算子を空の属性に対して使うことを防ぐように、前の演習の解答を変更してください。







14.6 Freeモナド

APIに施す最後の変更は、 Content型をモナドにしてdo記法を使えるようにするために、Freeモナドと呼ばれる構造を使うことです。Freeモナドは、入れ子になった要素をわかりやすくなるよう、HTML文書の構造化を可能にします。次のようなコードを考えます。

p [ _class := "main" ]
  [ elem $ img
      [ src    := "cat.jpg"
      , width  := 100
      , height := 200
      ]
  , text "A cat"
  ]


これを次のように書くことができるようになります。

p [ _class := "main" ] $ do
  elem $ img
    [ src    := "cat.jpg"
    , width  := 100
    , height := 200
    ]
  text "A cat"


しかし、do記法だけがFreeモナドの恩恵だというわけではありません。モナドのアクションの表現をその解釈から分離し、同じアクションに複数の解釈を持たせることをFreeモナドは可能にします。

Freeモナドは purescript-freeライブラリの Control.Monad.Freeモジュールで定義されています。 PSCiを使うと、次のようにFreeモナドについての基本的な情報を見ることができます。

> import Control.Monad.Free

> :kind Free
(Type -> Type) -> Type -> Type


Freeの種は、引数として型構築子を取り、別の型構築子を返すことを示しています。実は、 Freeモナドは任意の Functorを Monadにするために使うことができます！

モナドのアクションの表現を定義することから始めます。これを行うには、サポートする各モナドアクションそれぞれについて、ひとつのデータ構築子を持つ Functorを作成する必要があります。今回の場合、2つのモナドのアクションは elemと textになります。実際には、 Content型を次のように変更するだけです。

data ContentF a
  = TextContent String a
  | ElementContent Element a

instance functorContentF :: Functor ContentF where
  map f (TextContent s x) = TextContent s (f x)
  map f (ElementContent e x) = ElementContent e (f x)


ここで、この ContentF型構築子は以前の Contentデータ型とよく似ています。 Functorインスタンスでは、単に各データ構築子で型 aの構成要素に関数 fを適用します。

これにより、最初の型引数として ContentF型構築子を使うことで構築された、新しい Content型構築子を Freeモナドを包むnewtypeとして定義することができます。

type Content = Free ContentF


型のシノニムの代わりにnewtypeを使用して、使用者に対してライブラリの内部表現を露出することを避ける事ができます。 Contentデータ構築子を隠すことで、提供しているモナドのアクションだけを使うことを仕様者に制限しています。

ContentFは Functorなので、 Free ContentFに対する Monadインスタンスが自動的に手に入り、このインスタンスを Content上の Monadインスタンスへと持ち上げることができます。

Contentの新しい型引数を考慮するように、少し Elementデータ型を変更する必要があります。モナドの計算の戻り値の型が Unitであることだけが要求されます。

newtype Element = Element
  { name         :: String
  , attribs      :: Array Attribute
  , content      :: Maybe (Content Unit)
  }


また、 Contentモナドについての新しいモナドのアクションになる elemと text関数を変更する必要があります。これを行うには、 Control.Monad.Freeモジュールで提供されている liftF関数を使います。この関数の(簡略化された)型は次のようになっています。

liftF :: forall f a. (Functor f) => f a -> Free f a


liftFは、何らかの型 aについて、型 f aの値からFreeモナドのアクションを構築できるようにします。今回の場合、 ContentF型構築子のデータ構築子を次のようにそのまま使うだけです。

text :: String -> Content Unit
text s = liftF $ TextContent s unit

elem :: Element -> Content Unit
elem e = liftF $ ElementContent e unit


他にもコードの変更はありますが、興味深い変更は render関数に対してのものです。ここでは、このFreeモナドを解釈しなければいけません。

14.7 モナドの解釈

Control.Monad.Freeモジュールでは、Freeモナドで計算を解釈するための多数の関数が提供されています。

runFree
  :: forall f a
   . Functor f
  => (f (Free f a) -> Free f a)
  -> Free f a
  -> a

runFreeM
  :: forall f m a
   . (Functor f, MonadRec m)
  => (f (Free f a) -> m (Free f a))
  -> Free f a
  -> m a


runFree関数は、純粋な結果を計算するために使用されます。 runFreeM関数は、フリーモナドの動作を解釈するためにモナドを使用することを可能にします

厳密には、 MonadRecのより強い制約を満たすモナド mを使用する制限がされています。これはスタックオーバーフローを心配する必要がないことを意味します。なぜなら mは安全な末尾再帰モナド(monadic tail recursion)をサポートするからです。

まず、アクションを解釈することができるモナドを選ばなければなりません。 Writer Stringモナドを使って、結果のHTML文字列を累積することにします。

新しい renderメソッドは補助関数 renderElementに移譲して開始し、 Writerモナドで計算を実行するため execWriterを使用します。

render :: Element -> String
render = execWriter <<< renderElement


renderElementはwhereブロックで定義されています。

  where
    renderElement :: Element -> Writer String Unit
    renderElement (Element e) = do


renderElementの定義は簡単で、いくつかの小さな文字列を累積するために Writerモナドの tellアクションを使っています。

      tell "<"
      tell e.name
      for_ e.attribs $ \x -> do
        tell " "
        renderAttribute x
      renderContent e.content


次に、同じように簡単な renderAttribute関数を定義します。

    where
      renderAttribute :: Attribute -> Writer String Unit
      renderAttribute (Attribute x) = do
        tell x.key
        tell "=\""
        tell x.value
        tell "\""


renderContent関数は、もっと興味深いものです。ここでは、 runFreeM関数を使って、Freeモナドの内部で補助関数 renderContentItemに移譲する計算を解釈しています。

      renderContent :: Maybe (Content Unit) -> Writer String Unit
      renderContent Nothing = tell " />"
      renderContent (Just content) = do
        tell ">"
        runFreeM renderContentItem content
        tell "</"
        tell e.name
        tell ">"


renderContentItemの型は runFreeMの型シグネチャから推測することができます。関手 fは型構築子 ContentFで、モナド mは解釈している計算のモナド、つまり Writer Stringです。これにより renderContentItemについて次の型シグネチャがわかります。

      renderContentItem :: ContentF (Content Unit) -> Writer String (Content Unit)


ContentFの二つのデータ構築子でパターン照合するだけで、この関数を実装することができます。

      renderContentItem (TextContent s rest) = do
        tell s
        pure rest
      renderContentItem (ElementContent e rest) = do
        renderElement e
        pure rest


それぞれの場合において、式 restは型 Writer Stringを持っており、解釈計算の残りを表しています。 restアクションを呼び出すことによって、それぞれの場合を完了することができます。

これで完了です！PSCiで、次のように新しいモナドのAPIを試してみましょう。

> import Prelude
> import Data.DOM.Free
> import Control.Monad.Eff.Console

> :paste
… log $ render $ p [] $ do
…   elem $ img [ src := "cat.jpg" ]
…   text "A cat"
… ^D

<p><img src="cat.jpg" />A cat</p>
unit


演習

	(やや難しい)ContentF型に新しいデータ構築子を追加して、生成されたHTMLにコメントを出力する新しいアクション commentに対応してください。 liftFを使ってこの新しいアクションを実装してください。新しい構築子を適切に解釈するように、解釈 renderContentItemを更新してください。





14.8 言語の拡張

すべてのアクションが型 Unitの何かを返すようなモナドは、さほど興味深いものではありません。実際のところ、概ね良くなったと思われる構文は別として、このモナドは Monoid以上の機能は何の追加していません。

意味のある結果を返す新しいモナドアクションでこの言語を拡張することで、Freeモナド構造の威力を説明しましょう​​。

アンカーを使用して文書のさまざまな節へのハイパーリンクが含まれているHTML文書を生成するとします。手作業でアンカーの名前を生成すればいいので、これは既に実現できています。文書中で少なくとも２回、ひとつはアンカーの定義自身に、もうひとつはハイパーリンクに、アンカーが含まれています。しかし、この方法には根本的な問題がいくつかあります。


	開発者は一意なアンカー名を生成するために失敗することがあります。

	開発者は、アンカー名のひとつまたは複数のインスタンスを誤って入力するかもしれません。



自分の間違いから開発者を保護するために、アンカー名を表す新しい型を導入し、新しい一意な名前を生成するためのモナドアクションを提供することができます。

最初の手順は、名前の型を新しく追加することです。

newtype Name = Name String

runName :: Name -> String
runName (Name n) = n


繰り返しになりますが、 Nameは Stringのnewtypeとして定義しており、モジュールのエクスポートリスト内でデータ構築子をエクスポートしないように注意する必要があります。

次に、属性値として Nameを使うことができるように、新しい型 IsValue型クラスのインスタンスを定義します。

instance nameIsValue :: IsValue Name where
  toValue (Name n) = n


また、次のように a要素に現れるハイパーリンクの新しいデータ型を定義します。

data Href
  = URLHref String
  | AnchorHref Name

instance hrefIsValue :: IsValue Href where
  toValue (URLHref url) = url
  toValue (AnchorHref (Name nm)) = "#" <> nm


href属性の型の値を変更して、この新しい Href型の使用を強制します。また、要素をアンカーに変換するのに使う新しい name属性を作成します。

href :: AttributeKey Href
href = AttributeKey "href"

name :: AttributeKey Name
name = AttributeKey "name"


残りの問題は、現在モジュールの使用者が新しい名前を生成する方法がないということです。 Contentモナドでこの機能を提供することができます。まず、 ContentF型構築子に新しいデータ構築子を追加する必要があります。

data ContentF a
  = TextContent String a
  | ElementContent Element a
  | NewName (Name -> a)


NewNameデータ構築子は型 Nameの値を返すアクションに対応しています。データ構築子の引数として Nameを要求するのではなく、型 Name -> aの関数を提供するように使用者に要求していることに注意してください。型 aは計算の残りを表していることを思い出すと、この関数は、型 Nameの値が返されたあとで、計算を継続する方法を提供するというように直感的に理解することができます。

新しいデータ構築子を考慮するように、 ContentFについての Functorインスタンスを更新する必要があります。

instance functorContentF :: Functor ContentF where
  map f (TextContent s x) = TextContent s (f x)
  map f (ElementContent e x) = ElementContent e (f x)
  map f (NewName k) = NewName (f <<< k)


そして、先ほど述べたように、 liftF関数を使うと新しいアクションを構築することができます。

newName :: Content Name
newName = liftF $ NewName id


id関数を継続として提供していることに注意してください。型 Nameの結果を変更せずに返すということを意味しています。

最後に、新しいアクションを解釈するために、解釈関数を更新する必要があります。以前は計算を解釈するために Writer Stringモナドを使っていましたが、このモナドは新しい名前を生成する能力を持っていないので、何か他のものに切り替えなければなりません。WriterTモナド変換子をStateモナドと一緒に使うと、必要な作用を組み合わせることができます。型注釈を短く保てるように、この解釈モナドを型同義語として定義しておきます。

type Interp = WriterT String (State Int)


Int型の引数は状態の型で、この場合は増加していくカウンタとして振る舞う数で